SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/ SPECTRUM 5 Manual

CAPAROL

SPECTRUM

Manual Version 5




SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/ SPECTRUM 5 Manual

DISCLAIMER

Although the greatest of care has been taken in preparing this manual, the information contained
therein may not be regarded as a guarantee of product properties. Caparol is liable only to the extent
specified in the Terms of Sale and Delivery.

This manual may not be reproduced, transferred, edited or stored in a database system in whole or in
part without express written permissible from Caparol. The same holds for the translation into
another human or machine language, in any form or using any means, unless permitted under the
laws of the Federal Republic of Germany.

Caparol reserves the right to make changes to this document. In such a case, Caparol is not obliged
to inform any person or organisation of these changes unless so specified in the underlying delivery
contract or software licence.

For this reason, Caparol also does not assume any liability for any errors in the manual, resulting
indirect damage or compensation for damages arising through delivery, provision, and use of the
manual.

Caparol may own rights to patents and/or patents pending, trademarks, copyrights or other property
related to the subject matter of this document. Provision of this document does not however give the
user any claim to these patents, trademarks, copyrights or other intellectual property unless
expressly specified in the written delivery contracts or software licences.

All trademarks are registered trademarks of the respective companies.
© CAPAROL Farben Lacke Bautenschutz GmbH

CAPAROL Farben Lacke Bautenschutz GmbH
RoBdorfer StraBe 50

Industriegebiet 1

D-64372 Ober-Ramstadt

Germany

www.caparol.de

www.spectrum.eu



SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/

Table of contents

1. Introduction
1.1 Notes on using this manual
1.2 Overview of chapters
1.3 New features in SPECTRUM 5

2. Installation
2.1 System requirements
2.2 Installation of the program version and components
2.3 Activation of software
2.3.1 Activation with serial number
2.3.2 Activation with CmStick (Dongle)
2.4 Installation of basic data
2.5 Updates

3. Program overview
3.1 Structure of the program interface
3.2 Program navigation — modules
3.3 Main navigation
3.3.1 File
3.3.2 Edit
3.3.3 Studio
3.3.4 View
3.3.5 Extras
3.3.6 Help
3.4 Shortcut commands

4. EXPLORER

4.1 Menu bar in Explorer
4.1.1 Data view
4.1.2 Search
4.1.3 Help
4.1.4 Filters
4.1.5 Favourites

4.2 “Projects” tab
4.2.1 Samples EXTERIOR/INTERIOR
4.2.2 Own projects
4.2.3 Additional menu

4.3 “Collections” tab
4.3.1 Colour and material selection
4.3.2 Own collections

4.4 Filters

4.5 Favourites

5. PHOTOstudio
5.1 Menu bar
5.1.1 Open project
5.1.2 Save project
5.1.3 Print
5.1.4 Forward/Back
5.1.5 View buttons
5.1.6 Rocket mode
5.1.7 Help
5.1.8 Show/hide object listt
5.2 “Object list” tab
5.2.1 Create/remove object list
5.2.2 Object properties

Table of contents

~N OO

10
10
10
11
13

14
15
15
16
16
17
17
17
18
19
20

23
23
23
24
24
25
25
26
27
27
28
30
31
32
36
38

40
40
41
42
43
46
46
47
47
47
48
48
48



SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/

5.2.3 Brightness / contrast of objects / ColorChecker

5.3 “Prepare” tab
5.3.1 Tools: Area
5.3.2 Tools: Grid
5.3.3 Tools: Retouch
5.4 “Design” tab
5.4.1 Collections
5.4.2 Favourites
5.4.3 3D objects: CapaCoustic Melapor & NMC
5.4.4 Copy colours/materials into the object list
5.4.5 Multiview pictures

6. 3Dstudio
6.1 Menu bar
6.2 Camera settings

7. MATERIALstudio
7.1 Menu bar
7.2 Create individual samples
7.2.1 “Background” tab
7.2.2 "Coatings” tab
7.3 Use individual samples

8. SHOW
8.1 Menu bar
8.1.1 Views

9. SPECTRUM_cloud
9.1 Log In/registration
9.1.1 Registration
9.1.2 Log In
9.1.3 Forgot password
9.2 Data management
9.2.1 Download/upload my files
9.2.2 Download manufacturer data
9.3 Service
9.3.1 PHOTOservice
9.3.2 PRINTservice
9.4 Other functions

10. myMaterial-Manager
10.1 Structure of myMaterial-Manager
10.1.1 Select colour, material and favourites
10.1.2 Export colour, material and favourites
10.1.8 Return to SPECTRUM 5

11. Colour true- Calibration - ColorMunki
11.1 Simple colour optimisation (without ColorMunki)
11.1.1 Calibration
11.2 Calibration with ColorMunki
11.2.1 Display profiling
11.2.2 Printer profiling
11.2.3 Import of colour hues to SPECTRUM 5

12. SUPPORT
12.1 Training
12.2 Website
12.3 Contact

Table of contents

50
51
51
57
60
64
64
70
71
74
75

76
76
78

79
79
81
81
82
83

84
84
86

89
89
89
89
90
90
90
92
93
93
99
100

101
101
101
102
102

103
103
103
104
105
110
115

116
116
116
116



SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/ Introduction

1. INTRODUCTION

SPECTRUM 5 is based on more than 10 years of development work in the field of graphics software
with a focus on colour and material display. The result is innovative visualisation software which
stands out through the quality of photo-realistic images and surfaces.

SPECTRUM 5 allows you to design your own image data and numerous sample images. The
workflow is intuitive and easy to learn, offering even occasional users an easy approach to the world
of digital image processing. The visualisation software stands out in particular on account of the large
range of colour collections and surfaces it has available from many renowned manufacturers.

1.1 Notes on using this manual

This reference manual has been designed to make it easier for you to use the visualisation software
SPECTRUM 5. It will provide support with typical tasks you will encounter when working with the
software and give you tips on special program features.

You will find a summary of the manual’s contents as well as the new features of SPECTRUM 5 below.

Important additional information is marked “Note” in the manual.

Some chapters also contain references to other chapters that could be helpful in connection with
certain functions.

1.2 Overview of chapters

Chapter 1: Introduction
Introduction to Caparol SPECTRUM 5, information on the structure of the manual as well as an
overview of the new software functions.

Chapter 2: Installation
This chapter includes the system requirements for optimum use of SPECTRUM 5 and a guide to
installing the program.

Chapter 3: Program overview

This chapter gives you an overview of the basic structure of the SPECTRUM 5 interface, the five
modules, shortcut commands for the keyboard and an explanation of the pictograms used for the
Caparol colour collections.

Chapter 4: EXPLORER module

The EXPLORER chapter explains the contents of this module in more detail. Alongside an overview of
the images, projects, colour and material data, we explain the extended search possibilities with filter
settings.
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Chapter 5: PHOTOstudio module

Here, we show you how the new PHOTOstudio works, with the different preparation and design
options for your own image data or sample images, as well as the possibility of saving, printing and
exporting your variants.

Chapter 6: 3Dstudio module
This chapter will help you import virtual objects created with “Google Sketchup” to 3Dstudio and
prepare them for design, with the possibility of saving, printing and exporting the variants.

Chapter 7: MATERIALstudio module

This chapter provides information about the creation of your own colour and surface combinations
that can be used for design in both SPECTRUM 5 and external programs.

Chapter 8: SHOW module
The SHOW chapter will explain presentation possibilities for your variants, e.g., at the customer’s or
at the POS using direct comparison, collage and slide show.

Chapter 9: SPECTRUM_cloud

SPECTRUM_cloud is available immediately to store your Spectrum data free of charge. It gives you
access to the latest collections from Caparol and our manufacturing partners. You can also use the
PHOTOservice (image masking) and PRINTservice (true-colour printout). The cloud also enables
networking between different SPECTRUM applications.

Chapter 10: myMaterial-Manager
This chapter shows you how you can export selected materials for use in external programs quickly
and easily using the myMaterial-Manager.

Chapter 11: Colour true - Calibration - ColorMunki
Use the possibilities of optimising colour reproduction on your monitor display and/or printer for
realistic colour presentation of your variants in SPECTRUM 5.

Chapter 12: Support
This chapter provides information on training courses, technical support and the
SPECTRUM 5 website.



SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/ Introduction

1.3 New features in SPECTRUM 5

Here are the most important new features of SPECTRUM 5 compared with the predecessor version
SPECTRUM 4.0:

e SPECTRUM_cloud:
All SPECTRUM applications are now connected with the SPECTRUM_cloud.

e Touch optimisation and monitor size
The entire program interface has been optimised for touch screens.

e 3D objects:
Integration of NMC profiles and Melapor acoustic products in room images.

e Express
When you need to work quickly — edit without area masking in Express mode.

e Optimised image library
Each sample image is now available in three different colour variants, each developed by
professional colour designers.
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2. INSTALLATION

Before you can start using SPECTRUM 5, you must make sure that your PC meets the necessary
requirements (see chapter 2.1 for system requirements) for optimum software function. To install the
software, follow the steps shown in this chapter.

2.1 System requirements

For the installation of SPECTRUM 5 and subsequent use of the software, the following system
requirements must be met:

Operating system Microsoft Windows:
Vista | 7 | 8, 32 or 64-bit (with the latest respective Service Pack)

Processor: min. Intel Core 2 Duo 1.66 GHz

RAM: at least 2 GB, recommended 4 GB

10 GB free disk space on hard drive

DVD-ROM drive

Full version | Upgrade: USB socket for licence key (CM stick)
Internet connection (for software activation)

Graphics card: 32-bit, at least 1024 x 768 px

2.2 Installation of the program version and components

Insert the Caparol SPECTRUM 5 DVD in the DVD drive of your PC and click “Setup.exe” in the root
folder of the DVD. The Caparol SPECTRUM 5 installation wizard will start and guide you through the
installation process.

{3 SPECTRUM 5 Setup x|

Willkommen beim Setup
Assistenten von SPECTRUM 5

Der Setup Assistent wird SPECTRUM 5 auf Threm Computer
installieren. Klicken Sie auf "Weiter” um fortzufahren, oder
auf "Abbrechen™ um den Setup Assistent zu beenden.

< Zuriick I Weiter > I Abbrechen

Note: To ensure SPECTRUM 5 is installed correctly, we recommend deactivating the firewall during
installation.
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Acknowledge the license agreement.

i SPECTRUM 5 Setup
Endbenutzer Lizenzvereinbarung

Bitte lesen Sie nachfolgende Lizenzvereinbarung sorgfaltig durch.

x|
E

Softwarelizenzbedingungen

Wichtig: Durch die Installation dieser Software akzeptieren
Sie (nachfolgend Anwender genannt) diese
Softwarelizenzbedingungen von Caparol fir Spectrum 5
(nachfolgend Software). Soliten Sie mit nachfolgenden
Bedingungen nicht einverstanden sein, missen Sie
unverziglich die erworbene Software zurickgeben. Bere\tsll

{® Ich stimme der Lizenzvereinbarung zu

 Ich stimme der Lizenzvereinbarung NICHT zu

Advanced Installer

< Zurlick I Weiter > I

Abbrechen

Select a program directory.

Installation

C:\Program Files (x86)\CAPAROL\SPECTRUM 5\ is suggested by default

{& SPECTRUM 5 Setup

Installationsverzeichnis wihlen

g [ 3

Installationsverzeichnis von SPECTRUM 5,

Um in das angegebene Verzeichnis zu installieren, Kicken Sie bitte "Weiter”. Fiir ein

alternatives Installationsverzeichnis wahlen Sie bitte ein anderes Verzeichnis Uber
“Wahlen®.

Verzeichnis:

IC:\Program Files (x86)\CAPAROL\SPECTRUM 5Y

Wwahlen...

Advanced Installer

< Zuriick I Weiter > I

Abbrechen

The Caparol SPECTRUM 5 installation wizard will check during startup if all the required programs
have been installed. If this is not the case, the installation wizard for the necessary programs will be
opened automatically to guide you through their installation processes.

& SPECTRUM 5 Setup x|
Vorbereitung der Installation abgeschlossen

Der Setup Assistent ist bereit, mit der Installation zu beginnen,

Klicken Sie auf "Installieren” um die Installation zu starten. Wenn Sie die
Installationseinstellungen Gberpriifen oder &ndern méchten, kicken Sie auf "Zuriick™, Um
den Setup Assistent zu beenden, Kicken Sie auf "Abbrechen”.

Advanced Installer

< Zuriick I Installieren I Abbrechenl

Microsoft(R) Direct{(R) wird installiert

Willkommen
Microsoft®

DirectX

Software Development Kit

Der DirectX-Installations-Assistert fuhrt Sie durch die
Installation der DirectX-Laufzeitkomponerten. Lesen Sie bitte
den folgenden Lizenzvertrag. Mit BILD-AB kénnen Sie den
Obrigen Vertragstext anzeigen. Die Vertragsannahme ist
Voraussetzung fur die Installation.

MICROSOFT SOFTWARE LICENSE TERMS i’
MICROSOFT DIRECTX END USER RUNTIME

These license terms are an agreement between Microsoft
Corporation (or based on where you live, one of its

ffiliates) and you. Please read them. They apply to the
software named above, which includes the media on

which you received it, if any. The temms also apply to any
Microsoft

* updates. LI

€~ Ich stimme den Bedingungen des Verrags zu

" Ich stimme den Bedingungen des Vertrags nicht zu

& Zuriick

Weter | Abbrechen I

After the successful installation, close the assistant by clicking ,Fertigstellen®.
Subsequent you need to activate the software (see chapter 2.3 “Activation of software”)
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2.3 Activation of software

When all required components are installed, please start the SPECTRUM 5 software using the
desktop shortcut.

=ioix
SPECTRUM 5 ""“f"

CAPAROL
Es wurde keine Lizenz gefunden!

Herzlich Willkommen!
Es wurde keine Lizenz gefunden. An Threm Computer wurde keine giltige
SPECTRUM-Lizenz gefunden: CmStick 4004500.

Sollten Sie tber keinen CmStick oder Seriennummer verfiigen, dann kénnen
Sle diese erwerben oder eine kostenlose Testversion bestellen.

Bitte wahlen Sie eine der folgenden Optionen

Seriennummer zur Softwareaktivierung eingeben ‘

SPECTRUM i US8-Lizen: (Cmstick)starten |

Abbrechen ‘

Sie haben keine Seriennummer?

Seriennummer fiir
30-Tage-Testversion anfodern

Vollversion bestellen ‘ ‘

I 2013 DAW Stiftung & Co KG
o O s o

2.3.1 Activation with serial number

Click ,,.Seriennummer zur Softwareaktivierung eingeben” and insert the 25 digit serial number you
received along with the installation DVD.

Please pay attention to capital and small letters. An internet connection is necessary.

The installation of the basic data will start automatically (see chapter 2.4 ,Installation of basic data“).

SPECTRUM 5.0 Lizenzaktivierung x|
Bitte den SPECTRUM 5.0 Lizenz-Code eingeben:

OK | Cancel |

Note: SPECTRUMSstudent only works in connection with a serial number and can’t be combined with
a CmStick. Please also note, that the student version can only be installed and used on one
computer.

2.3.2 Activation with CmStick (Dongle)

Insert the CM stick (your licence key for the full version and the upgrade) into the USB port of your
computer and click ,SPECTRUM mit USB-Lizenz (Cmstick) starten”.
The installation of the basic data will start automatically (see chapter 2.4 ,Installation of basic data”)

Note: With the CmStick you can install the program on various computers. For working with
SPECTRUM 5 the CmStick needs to be connected to your computer.

10
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2.4 Installation of basic data

After the successful activation the asssistant for the data installation will appear.

?
I.
|

Select a language.

Then select the work/data directory.
All library images and textures will be stored in this directory.
The installation DVD must be inserted in the drive.

Copy

E I

11
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All the data is copied to your PC. This may take several minutes.

!I
.I

After confirming with ,,Beenden” the installation is completed and you can start working with
SPECTRUM 5.

!
E
I.{

12
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2.5 Updates

When you start the program, SPECTRUM 5 informs you of the availability of updates. If you receive
information that an update is available, always install it to ensure your software is up-to-date.
Updates are provided free of charge.

Alternatively, you can also install updates manually, through the “Extras” > “PROGRAM Update”

menu path.

Note: The updates offered to you when you start the software only update the program itself. If you
want to upload new colours or materials, use the SPECTRUM_cloud (see chapter 9).
When you select “Extras” > “DATA Update”, SPECTRUM checks and updates your data.

13



SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/ Program overview

3. PROGRAM OVERVIEW

3.1 Structure of the program interface

Ié1 A [5‘ ‘jﬂ[‘; 1.) Program navigation - modules
[ P I w—T ) PO®
: ) _{ 2.) Main navigation
L
3.) SPECTRUM_cloud
EEEEEN
IiEm m EEEEER 4.) Menu bar
| u EEEEEN |
im = EEEEEE 7
H N
"N HEEEN
HE H N HENED
H BN H N HEEEN
H N = HEEN
/H m H HEN U

1.) Program navigation - modules

The program navigation is located in the top left-hand section of the screen and contains the five
modules EXPLORER, PHOTOstudio, 3Dstudio, MATERIALstudio and SHOW. These buttons can
be selected from anywhere and enable users to change between modules. For detailed information
about the way the individual modules work, see chapters 4 to 8.

Elr 3|M[S]

2.) Main navigation

The main navigation is located at the top of the screen and, depending on the currently active
module, contains the following options: File, Edit, Service, Studio, View, Extras and Help. These
options will be explained in more detail in chapter 3.3. You also have access to the
SPECTRUM_cloud here (chapter 9).

File Edit Studio View Extras Help SPECI’RUMQ

=

4.) Menu bar

The function buttons for the individual modules can be selected directly under the coloured line of the
modules in the central screen area. With the aid of these symbols you can import, expert, save or
print data, depending on the module. The buttons are explained in more detail in the respective
modules.

(& | change view | (@) | (@ x] | (]

14
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5.) Tabs

Depending on which module is currently active, the right and left margins of the program window
contain various content and tools, which you can open by clicking the respective tab name. The
contents of the tabs are explained in more detail in the respective modules.

[ Projects Collections
[

3.2 Program navigation - modules

In the main navigation area, you see the buttons of the five modules, which are always visible. These
buttons let you switch back and forth between the different areas of the program.

EXPLORER

PHOTOstudio

3Dstudio

MATERIALstudio

D280

15
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3.3 Main navigation

The main navigation is visible from every area. Depending on the module currently chosen, it may
contain different functions that are characteristic for the particular module in question.

3.3.1 File

The contents of the “File” menu vary in the save, print and open options depending on the module.
The “File” menu always contains the possibility of closing the program using “Close”.

Lalnis|

. i s g e I - §
. [C—]] o v e
. [l

EEEEEN
HEN EEEEEN
HENR EEEEEN
HEN EEEEEN
HEBN [
EEEN EEHEN
EEEEN HEEN
EEEEN EEEE"
HEEHEEN HEHEN
HEEEN HE N U

16
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3.3.2 Edit

The “Edit” menu lets you edit the active object. The possible edit options differ by module.

e
[ exPLORER  =lolx|
Ia P 8 M S File | Edit | Studio View Extras Help SPECTRUM. )] ﬂuﬂ.‘k
Cut Strg+X
Collections @ Copy Strg+C X | @ @ @
Paste Strg+V
Govarg Delete
ﬂ Caparol Filters:
Rename Strg+R

Rename projectfolder

Delete projectfolder
Rename collectionfolder

Delete collectionfolder

3.3.3 Studio

In the “Studio” you can change between the individual modules. Alongside an overview of the
modules, you can also find access to the SPECTRUM_cloud here.

[ EXPLORER - =lolx]|
la P 8 M S File Edit | Studio | View Extras Help sPECrRUMg ![‘.lﬂ,lk
[E] ExPLORER
cotlections | [ | chansd g srorostuco I x| () (7] (]
3Dstudio
Caparol: 3D-! <
? [ MATERIALstudio
ﬁ Caparol Filters: None
SHOW
SPECTRUM_cloud .

3.3.4 View

The “View” function is available as a navigation item in all modules. More information about the
“View” functions is available in the respective modules.

[ EXPLORER ] z['

la P 8 M S File Edit Studio | View | Extras Help spscmumg (—‘,ﬂmlt

Small symbols

A e ® ¥

Large symbols

Caparol: 3D-System p| Ao ittt
Filters: None Show all Pictures

M Caparol

Show Filter
Show favourites

17
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3.3.5 Extras

You have a choice of five different functions under “Extras”.

[ EXPLORER - 3 Du I‘:
= File Edit Studio View [ Extras [Help SPEGRUM/_‘\ (“"""
=] = myMaterial-Manager :

Projects Collections H ] Change view PROGRAM-Update X ] | 2 B

DATA-Update

Caparol: 3D-System plus _— ]
ID'M_P caparol Filters: None Colour settings x

Options

Register .

10 Top 10

Own collections

NCS

e Il BN BN BN B .

myMaterial-Manager

Click “myMaterial-Manager” to reach the “myMaterial-Manager” view of SPECTRUM 5.

In this function, you can transfer all colours and materials from the “Collections” area to other
programs, such as Microsoft Word, easily with drag-and-drop.

For more information, see chapter 10, “myMaterial-Manager”.

PROGRAM-Update
Click “PROGRAM-Update” to install the latest SPECTRUM 5 update on your computer. Refer to
chapter 2.3 as well.

DATA-Update
This function lets you check your collection, library and MATERIALstudio data for current content and
update it if desired. You can also update your full dataset.

Colour settings
The “Colour settings” button can be used to calibrate your monitor/printer with the calibration bars or
the X-Rite ColorMunki. For more information, see chapter 11 “Colour true — calibration — ColorMunki”.

Options

Open the “Options” to set up the computer or network configuration. Under “General Settings”, you
can customise the program directory, work/data directory and country/language settings.

Under “Advanced Settings”, you can perform a data backup of all your previous projects. This copies
all your project data to your target medium (a USB stick, for example). You can use “Restore saved
projects” to upload your data backup into the program.

You can also activate and deactivate the wizard display in PHOTOstudio and notifications of
automatic updates in this section.

Note: When you “Restore saved projects”, projects with identical file names will be overwritten.
Newly created projects with different project names are retained.

18
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Register

Program overview

This option takes you directly to the register area of SPECTRUM_cloud. It is only accessible through
the Internet and lets you sign up for your own personal SPECTRUM_cloud access.

3.3.6 Help

Clicking “Help” displays the online version of the SPECTRUM 5 user manual (active Internet
connection required). The shortcut command for the help function is “F1”.

The “Info...” area provides information about your current SPECTRUM 5 version. The update version
is described using the last digit and date.

[ ExPLORER

5 o]
Ia PI3(M|S File Edit Studio View Extras | Help | SPECTRUN-D gﬂ..t
Online Help  F1
Projects ’ Collections @Chanueview ‘ Support X | [9 Y [t
Imprint
Caparol: 3D-System plus _
U caparol Filters: None Info..
10 Top 10

Own collections

EGGER
Alpina

19
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3.4 Shortcut commands

The use of shortcut commands makes it easier and faster to use PHOTOstudio and the EXPLORER:

B O O (R

i ) = 2
(i3 1 2 23 M4 s 6 7 (M8 (Mo JM o M6 \

PHOTOstudio
= Page up
1.' 5 General: Zoom in (make image larger)
Alternative: scroll using the mouse wheel
Page down
i"" General: Zoom out (make image smaller)
Alternative: scroll using the mouse wheel
Space bar + click General: Move image (alternative drag keeping the right mouse button
pressed)
A
Backspace
<« Prepare/area: Delete point (last added point is deleted,

Prerequisite: area is open)

Del
Prepare/area: Delete point (select point, then click Del)
Note: If the end point of an area is deleted, it opens again and can be edited

further
A | p Shift + click
|8 Prepare/area: Create straight line between two points
, (keep Shift pressed)

20
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A
A Prepare/area: Select all areas of an object
(“Prepare”/“Area” tabs)
Ctrl
Sirg Prepare/area: Move selection
l (move the mouse while holding the Ctrl key)
E ; E + click
[ Prepare/area: Scale mode: Use “E” to change to “Scaling”
€ mode, click a spot to set vanishing point (= initial point for scaling), use the
§ “A” key to select all, keep “Ctrl” key pressed and drag keeping the mouse
button pressed
| I
Prepare/area: Invert selection
R : R + click
& Prepare/area: Rotation mode: Use “R” to change to rotation mode, click a
L spot to set the rotating point (= initial point for rotation), use the “A” key to
— select all, keep “Ctrl” key pressed and rotate, keeping the mouse button
pressed
S S
Prepare/grid: Insert point in area/corner grid
= (keep “S” pressed and click a horizontal line)
y Ctrl + click
Sirg 53 Prepare/retouch: In stamp mode: Define source point
e o=y
7 Ctrl+ 2
Sirg } Design: Undo one step
!
e ey f_=‘-l
S Ctrl + S
Sirg Design: Save an intermediate status in PHOTOstudio under an already

defined name.

21
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Ctrl + Shift + S

B P S | Decorate: Save a design in the PHOTOstudio
Sirg i U i | with the issue of a new name

T Ctrl + P

Sirg I

Decorate: Print your draft

EXPLORER
T N | Ctl+N
Sirg l l Create new project
Del
Ent! Delete file (select file, then click Del)

T X . Ctrl+ X
Sieg l I Cut file

Ctrl+ C

Sirg . C i Copy file

Ctrl +V

Sirg I v i Paste file
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4. EXPLORER

This module provides a clear overview of all the colour, material and image data as well as users’
own projects and favourites. The search function and filter settings help you to select specific colours
and materials. New interfaces can be added from the SPECTRUM_cloud.

This chapter explains the individual EXPLORER tabs and their functions in detail.

FEm

mmmmmw — 1.} 4.1 Menu bar
s | ] hrion == @
e % 2.) 4.2 “Projects” tab
(]
3.) 4.3 “Collections” tab
EEEEEN .
EEEDN EEEEENR 4.) 4.4 Filters
= = = = = = = = = = 5.) 4.5 Favourites
HEEN |
EEEN EEEEN
EEEENE EEREENRD
EEEEN EEEET
EEENT EEENET
mEE N EEE i

4.1 Menu bar in EXPLORER
(&) chance view 1@ | (® x) | ®) (7) (*)

4.1.1 Data views

You can choose between five different views for presentation of the sample images, colours and
materials in the EXPLORER in SPECTRUM 5:

[E Change view |
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View sizes XS and S
This minimised view of all images, colours and materials, without any other product information, is
ideal for viewing as many products as possible at a glance, to gain an overview.

View size M

This view provides you with a larger presentation of the product as well as the product name — and
for colours and materials, the “Info” button for detailed information for the product (see chapter 4.3.1,
“Colour and material selection”). This view is particularly suitable for having a look at many products
at once and seeing the initial product information. This is the default view size for products.

View sizes L and XL

This view shows the image, colour and material data in a large view with the possibility of a detailed
information display with the “Info” button (see chapter 4.3.1, “Colour and material selection”). It is
especially suitable for viewing product details during a search.

List view

7 N\

B

Under “Projects”, this view shows or hides the library images with the three professional colour
schemes. This gives you a quick overview of all available images.

Note: You can also change views with “View” in the main navigation.

4.1.2. Search

(a X )

You can use the search function in the menu bar for all the EXPLORER tab contents. In the
“Collections” tab, for example, you can enter the name of a colour in the search field, which will result
in all the colours with this generic name being displayed. If the “Projects” tab is open, you can search
for project details (such as postal code, project name etc.), which then displays the project folders
which contain these search criteria. Always confirm your entry by pressing the “Enter” key or clicking
the magnifying glass icon to start the search.

4.1.3. Help
()

\ /

The “Display help” button displays the online version of the SPECTRUM 5 user manual (active
Internet connection required).

Alternatively, you can also call up “Help”/“Online help”. The shortcut command for the help function
is “F1”.
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4.1.4. Filters

v

The filter feature within the “Collections” tab provides additional functions to optimise the product
search. You could filter and display the Caparol 3D System plus collection by lightness value, colour
area and product, for example.

For more information, see chapter 4.4, “Filters”.

4.1.5. Favourites

(*]

You can save certain colours or materials that you use regularly under “Favourites”.
For more information, see chapter 4.5, “Favourites”.
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4.2 “Projects” tab

Projects

123 samples INTERIOR

The “Projects” tab provides an overview of all the image data (sample images and your own imported
images) which you can use to design in SPECTRUM 5. This is also where you create and manage
your own projects.

4.2.1 Samples EXTERIOR/INTERIOR

SPECTRUM 5 contains more than 200 sample images from different countries. Each image is
available in three design variants.

B
EEEEE ~ o v con o ;
Bl PO ca—) ® s

‘Somples INTERIOR
Werking 01 02 Werking 03 v3 v
nyi @

<

1 VL

Werking 03 41
Working 05 91
Werking 07 41

E
-

Image selection

Under the “Projects” tab, you can choose between the “Samples EXTERIOR” and “Samples
INTERIOR” categories for sample images of fagades (e.g., business, family home, etc.) and interior
rooms (e.g., office, living room,...). In the “Own projects” section you will find the project data you
have created with your own photos and designs (for more information, see “Own projects”).

In order to view the sample images from one sub-category (e.g., Living, Restaurant, ...), select them
by clicking.
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Loading an image into PHOTOstudio for design work

Double-click an image or click the “P” button at the lower right corner of an image to load it directly
into PHOTOstudio for design work. The SPECTRUM 5 program interface changes to the
PHOTOstudio module (PHOTOstudio see chapter 5).

4.2.2 Own projects

When you create your own projects, SPECTRUM 5 gives you the possibility of saving image and
show data in a self-created project folder, helping you to manage the data easily. The “Own projects”
folder remains empty until the first “new project” has been created.

[+ EorTy —
| & GEINEIEE e
chan
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A Samples EXTERIOR 1) |40) (e8] |68 =

=1 Somples INTERIOR | ) ]
8 o ot ‘ P ?j
© 3

Maller

‘Sielaff Bernd

V14-0016.

Create new project

To create a new project, click the “+” symbol at the top of the list or select “File” > “Create new
project folder” in the main navigation (shortcut command: Ctrl+N). The “Customer data” window
opens, where you enter a project name and optional project details, such as hame, contact data etc.
Give the project a unique project name (such as “Meyer Family”). Then click “OK”. The newly created
project folder will now appear in your “Own projects” list.

Delete project

E

To remove an existing project irrevocably from the list of your projects, first select the project by
clicking the project name (it has been selected when the project name is highlighted in white and the
contents are shown in the workspace). Then click the “-” button.

To delete individual images or shows, click the image to select it and then click the “-” button
(“Delete project”) in the white bar above it. You can also delete an individual project with the “Del”
shortcut command.

Note: Projects that have been deleted cannot be recovered.
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Edit project details

3¢

. /

To change project information, for example, in order to add a remark or address data, click a project
folder and then click the “Gear” icon. The “Project details” window opens. Confirm your changes by
clicking “OK”.

4.2.3 Additional menu

.'. ] Change view | |:| | [ Q X J | |§
B

8/

O;I(
84

r

Import image data
[ =)

|
To import your own image data into SPECTRUM 5, click the “Import” button in the additional white
toolbar.
When the dialogue window opens, you can access the data on your PC or data carrier (e.g., USB
stick) by clicking to select the image you want. Now click “Open”. In the next step, you can perform
any necessary image corrections, such as rotate, reflect, or contrast/brightness corrections. Click
“Next”; the list of your projects is displayed. Select the project where you want to save the image or

create a new project folder. Enter a unique variant name for the image and click “Save”. The image is
saved in the corresponding project folder and opens automatically in the "PHOTOstudio module”.

Importing Spectrum 4.0 data

%
4.0

\

The image data you processed in SPECTRUM 5 are not lost in the new SPECTRUM 4.0 program
version (prerequisite: you are using SPECTRUM 5 on the same PC as Spectrum 4,0).

First, select the target folder for the image you want to import under “Own projects” in SPECTRUM 5.
You can click the “Import Spectrum 4 project” button in the white toolbar or choose “File” > “Import
Spectrum 4 data” to access your Spectrum 4.0 data. In the window that opens, first select one of
your SPECTRUM 4.0 project folders. Then click a variant in the project folder which you want to
import into SPECTRUM 5. Then click “Open” to import the selected image into the SPECTRUM 5
project folder.
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Pack‘n’Go
The Pack’n’Go function is used to exchange image data including all surfaces, grids and design
between different PCs using Spectrum 5.

Pack‘n’Go import

—

0|
In order to import an image exported with Pack'n’Go to into SPECTRUM 5, select the project folder
into which you want to import the image under “Own projects” and click the “GO-Import” button
(alternative: “File” > “Pack'n’Go import”). A window opens where you can access the data on your

PC. Choose the file you want from your hard drive or an external data carrier and click “Open”. The
image is now imported to the project file you selected.

Pack‘n’Go export
J

GO

\ /

To export an image, select the desired image in a project folder under “Own projects” and click the
“GO-Export” button (alternative: “File” > “Pack‘'n’Go export”). A window opens where you can
choose the target folder you want for the image (e.g. an external data carrier such as an USB stick).
Confirm with “OK” and the image will be exported to the target location with file extension “.SP5”.

Note: To export a whole folder you select it on the left side and click the "GO Export" button. Each file
is then exported individually to the storage medium you have selected.

Delete project

)

To delete a project, click the project to select it and then click the “Delete project” button in the upper
right corner. Confirm the prompt with “Yes”.
Alternatively, you can delete a project with menu path “Edit”/“Delete file”.

Note: The deleted files are moved into the Windows trash can from which they can be restored.
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4.3 “Collections” tab

@ Caparol

The “Collections” tab contains all colour and material selections for Caparol and our manufacturing
partners for use in your colour designs. You can also create your own collections, for example, with
wallpapers you have photographed yourself.

Materials from other partner manufacturers can be downloaded from the SPECTRUM_cloud free of
charge, to supplement the existing selection of collections (see chapter 9).
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4.3.1 Colour and material selection

To display individual collections, first click a manufacturer in the list to select it (Caparol is the default
selection). In the list below it, activate the collection whose contents you want to see. The view
displays all colour and material data for the collection.

Colour and material details

&

Information for a colour and material can be displayed in the “M” to “XL” views (see chapter 4.1.1,
“Data view”) by clicking the “i” button in the lower right corner of a displayed sample in the view area.

[= === lolx]
| & EIEIME R .
- Collections ] 3 | change view | @ (] [*]

([

A window opens in the foreground which contains the selected pattern in an enlarged view, along
with information such as manufacturer, collection, name etc. You can change the view size beneath
the sample display.

You can also use the “Export” button to save the colours/materials on your computer as jpeg, tiff or
png files. To do so, click the Save icon, enter a name and choose “Save”. To print the colour/material
area, click the “Create PDF-file” icon. SPECTRUM 5 automatically generates a PDF file, which you
can save and/or print.

To close the details, click the “X” at the top right corner of the window.
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4.3.2 Own collections

Create new collection

L+

To create a new collection folder, click the “+” icon at the top of the list or choose “File” > “Create
new collection folder” in the main navigation. A new window opens in which you enter the folder
name.

Enter an appropriate collection name. Then click “OK”. The new collection folder now appears in the
“Own collections” list.

Delete collection folder

o

. /

To remove an existing collection folder irrevocably from the list of your collections, first select the
collection by clicking the collection name (it has been selected when the collection name is
highlighted in white and the contents are shown in the view area). Click the “-” button and confirm
with “Yes” to delete the folder.

To delete individual image data, click the “X” at the upper right edge.

Note: Collections/image data that have been deleted cannot be recovered.

Importing your own images
To import your own collection content, first click the collection folder in which you want to save the
image data. Click the flower icon in the additional menu bar. In the window that then appears, click
the icon on the upper left to access the data on your computer. Select the desired collection image

and click “Open”. Then specify the required width and height in cm for your image, and optionally a
name. Then click “OK” — the image is saved in the selected collection folder.

If you want to import your image with a non-proportional aspect ratio, deactivate the tick mark
between height and width and enter the desired dimensions. The image is then imported with the
desired distortion.

You can apply the option "Tile image" to an image. The image is then repeatedly displayed on the
specified width/height pitch if, for example, you place it on a larger wall.

Deactivate the function "Tile image" if the image is only to appear once on the wall.

Note: When selecting your image dimensions, keep the image size required in PHOTOstudio in mind.

Note: You can import the following formats: tif, jpg or png with transparent background.
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Changing image sizes

&

In the views "M - XL" the "i" button is visible. On clicking the "i" button a new window opens.

You have the possibility of changing the size of an image retrospectively.

You can rename the file by entering a new name in the input field "Material name" and clicking on the
"OK" button.

To close the material details, click the “X” at the top right-hand edge of the window.
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Import with ColorMunki

The X-Rite ColorMunki lets you import colours and save them in “Own collections”.
To do so, connect the ColorMunki to your computer. Then click the “Import with ColorMunki” button
and follow the instructions.
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ColorPen sync

You can use the interface between ColorPen 3D and SPECTRUM to import all the colours samples
produced with ColorPen 3D and save them in a collection folder under “Own collections”, and then
use them for design work in SPECTRUM.

Connect the ColorPen 3D to your computer and then click the “ColorPen sync” button. All sampled
colours are then copied from ColorPen 3D to the active collection folder.

Importing collections using a TXT file
Using the "TXT" button, you can import colour collections into SPECTRUM for use in your design.

The file with the RGB values must be available as a TXT file.
The structure of this file must conform as follows below:

— Bl
@ A9 1= | SAMPLEcolours for IMPORT ot - Microsoft Bxcel | o[ [l
Start Einflgen Seitenlayout Formeln Daten Uberpriifen Ansicht a o o @ R
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1 |item_name

2 Farbtonbezeichnung _A
3 |Farbtonbezeichnung _B
4 Farbtonbezeichnung _C
5 |Farbtonbezeichnung _D
6 Farbtonbezeichnung _E
7 Farbtonbezeichnung _F
8 |Farbtonbezeichnung _G 82 32 43

v
4 4> M| SAMPLEcolours_for_IMPORT /%3 ) nENl il ] |
ILﬂereiq |[EEm 100% (o) O—@J

Note: If you have produced an RGB list in Excel, it must be saved as a TXT file.
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First, generate a new folder with the symbol "+" in the upper section of the list.
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You then import the desired collection with the "TXT" button in the tool bar.

LS
7
Once the import has finished, the colours are displayed in your folder and are available for further
design work in your SPECTRUM version.
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4.4 Filters

7]

SPECTRUM 5 features extended functions to optimise the product search within the “Collections”
tab.

To use the filter functions, click the “Filter” button in the upper right of the EXPLORER menu bar. The
tab that opens provides three different filter options by “Lightness value”, “Colour range” and
“Product”. All set filters are displayed in the white status bar beneath the menu and can be reset by
clicking the “X”.

Lightness value

Enter a minimum and maximum lightness value to limit the value, either by using the arrow keys or
entering values directly in the adjacent fields. Only those colours within the desired lightness value
range are displayed. This is helpful, for example, when a lightness value of 20 should be the minimum
limit for fagades with heat insulation for technical reasons.
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Colour range

You can choose from fourteen defined colour ranges to limit your search for colour ranges within a
colour collection. You then see a reduced view of all database entries in the respective colour range.
The selected colour range is highlighted in white.

P
o — Bl 3l

Caparol: CLASSIC
Fiters: Colour range: Bhue.

Product

You can use the product filter to limit your selection to a certain basic material. You are then only
shown the colours that can be produced in this product.

If you want to cancel a filter for a product, click “(No product)” in the list or reset the filter by clicking
the “X” in the white status bar beneath the menu.
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Note: All filter settings are visible in the white bar above the colour/material display. As a result, you
can see exactly which settings you have defined.
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4.5 Favourites

(*]

You can save certain colours or materials that you use regularly under “Favourites”. Add favourites to
the “SPECTRUM 5” standard set or create your own new favourite sets and fill these with the colours
and materials you require.
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Add/remove sample to set of favourites

Add a colour or material to a set of favourites by simply clicking the desired sample in the view area.
A second click on the product removes it from the set of favourites (alternative: select the sample you
want to delete from the set of favourites and click the “-” button).

If you want to add several products to a set of favourites at the same time, click the first product to
select it, then press and hold the “Shift” key and click the last product you want to import. All
products between the two selected products are automatically added to the current set of favourites.

Note: Products you add to favourites are automatically saved and are available as individual archives
when working with SPECTRUM 5 until you delete them.

Create new set of favourites

Alongside saving colour and material samples in the “SPECTRUM 5” set of favourites, it is possible
to create further sets of favourites that you can fill with the colours and materials used for certain
projects, for example.

Add a new set of favourites by clicking the “Create favourite” button (star +) in the Favourites tab. A
window opens for you to enter a name for the new set of favourites. After confirmation by “OK” the
new empty set will automatically appear in the dropdown menu of the “Favourites” tab. Fill your set
of favourites by clicking individual colour and material samples in the colour and material tabs (see
“Add samples to favourite set”).

Note: Samples selected are always added to the set of favourites currently being shown in the

dropdown menu. For this reason, always select the required set of favourites before you add further
samples.
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Copying colour/material into another favourites set

If you would like to copy a colour/material into another favourites set, click the desired sample and drag it
onto the name of the set with the mouse key pressed. The favourites list with all its entries opens.
Release the mouse key over the set into which you would like to copy the sample. The selected
favourites set opens and the sample is displayed in it.

Delete set of favourites

(%]

If you would like to remove a complete set of favourites with all its contents from the Favourites tab,
choose the set to be deleted. Then click “Delete favourite” (star -) in the “Favourites” tab and confirm
your choice by clicking “Yes” in the window that opens. The set of favourites no longer appears in the
list and has been irrevocably deleted.

Rename set of favourites

35

You can rename an existing set of favourites with “Rename favourites” (star-text icon) in the tab.
Activate the set you want to rename in the list, then click the “Rename favourites” icon. Enter the new
name in the window that opens. Then click “Save”. The window closes — and the set now has the new
name.

Display product details

i)

To display information about the name and other details of a product, click the “i” button (see chapter
4.3.1, “Colour and material selection”) in the large sample view (see “Views” below).

Delete product from set of favourites
To delete a single product from a set of favourites, first click the image of the product you want to
delete and then click the “-” button.

Two views are available to display the colour hues and materials in a set of favourites. The small
sample view lets you see the maximum number of samples from your set of favourites at the same
time. The large sample view shows you an enlarged display of the colours and materials; you can
also display the corresponding names and other information with the “i” button (see chapter 4.3.1,
“Colour and material selection”).
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5. PHOTOstudio

PHOTOstudio makes it possible to edit and design images. The “Prepare” and “Design” tabs are
available to help you quickly visualise your variants.

PHOTOstudio allows the editing of users’ photos, sample images or planning documents. Image data
can be retouched, masked and then designed with the full range of colours and materials in the
software.

Lol
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3.) 5.3 “Prepare” tab
C— : t 2 : 4.) 5.4 “Design” tab

5.) Workspace

5.1 Menu bar

The menu bar in PHOTOstudio contains buttons for the following functions: Open/Import,
Save/Export, Print, Forward/Back, View Size, Rocket Mode, Help and Object List (see chapter 5.2,
“Object list” tab).
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5.1.1 Open project

Dol

=

N~/

When you click the “Open project” button a window with several options appears.

Open options x|

&2 v

o

Import

@)

Open from SPECTRUM_cloud

Cancel

Open

To load an existing image from the EXPLORER database, click the “Open” button (alternative: main
navigation “File” > “Open project”). A window opens to display the projects in EXPLORER. Click the
mouse to select the desired image from the INTERIOR/EXTERIOR samples or one of your own
projects (image selection: see chapter 4.2, “Projects” tab), and click “Open” to confirm.

Import

If you would like to import a personal image for editing and design to PHOTOstudio, click the
“Import” button (alternative: main navigation “File” > “Import new photo”).

When the dialogue window opens, you can access the data on your PC or data medium (e.g., USB
stick) and select the image you want. Click “Open”. In the next step, you can perform any necessary
image corrections, such as rotate, reflect, or contrast/brightness corrections. Click “Next”; the list of
your projects is displayed. Select the project where you want to store the image or create a new
project folder (create project: see chapter 4.2.2, “Own projects”). Enter a unique variant name for the
image and click “Save”. The image is uploaded to PHOTOstudio for editing. (Variant creation: see
chapter 5.3, “Prepare” tab.)

Note: Photos can only be imported in jpeg, tiff or png format. The image resolution should be at least
1920 x 1440 pixels at 150 dpi, to ensure that the variants can be printed in sufficient quality.
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Open from the SPECTRUM_cloud

If you have an Internet connection, you can download projects to the software from your personal
SPECTRUM_cloud access. When you click the “Open from SPECTRUM_cloud” button, the program
automatically opens the login screen of the SPECTRUM_cloud in the Internet. Enter your personal
access data to log in.

You then go to the upload/download area automatically. Select the desired image and download it to
PHOTOstudio in SPECTRUM. (Upload/download: see chapter 9.2.1, “Download/upload my files”).

5.1.2 Save project
When you click the “Save project” button, a window with the various save and export options
appears.

[ Cancel

Save
F

After you have designed an image, save the variant by clicking the “Save” button (main navigation
“File” > “Save”). If you have redesigned a library image, the “Own projects” window opens. In this
window, you can assign the image to an existing project or create a new project folder (see chapter
4.2.2, “Own projects” for information on how to create a project). Give your image a new variant
name.

If you design a variant from “Own projects” and click “Save”, the name and storage location remain
the same. This means the previous variant is overwritten.

Note: We recommend saving the image from time to time during editing and designing, to prevent

your work being lost if the program or computer crashes (shortcut: Ctrl+S; main navigation
“File”>"“Save”).
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Save as

If you have worked on a project from “Own projects” and want to save it under a new name or
storage location, choose “Save as”. The “Own projects” window opens. In this window, you can
assign the image to an existing project or create a new project folder (see chapter 4.2.2, “Own
projects” on how to create a project). Give your image a new variant name.

Export

This button allows you to save your variant on your PC or external storage medium as a jpeg, tiff or
png file. Give the variant a file name in the dialogue window that opens, choose the target location
and click “Save”. This enables you to send the variant image as an e- mail attachment to customers,
for example, or use it further in other applications.

5.1.3 Print

When you click the “Print” button, a dialogue window appears with the different print modes (main
navigation: “File” > “Print”).

Print options i x|

Create PDF-file
Print

l: Cancel
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Create PDF-file

PDF

Click the “Create PDF-file” button on the menu bar to print the variant currently being shown. The
dialogue window that opens gives you the choice between a letter or full screen layout for PDF
creation. In addition, a list of materials of all the colours and materials used, including thumbnails and
exact product description, can be added and printed out.

X
Objektname:

T —
| Einfamienhaus 01 |

O Company © Mr. O Mrs. - 3
Title: 'g‘!’

ma

Name:
@ Letter O Full screen ¥ List of materials
e \
Street / No.

Musterstrasse 0 ‘

Postco  Ort:

Embed personal logo:

Cell number

000-000 |

MALER PROFI

max@mustermann.de | i
L ogo_MalerProfi

Text

Text

Print Close

Letter
In addition to an area for your customer’s contact data, the letter layout includes a thumbnail view of
your variant. This is the option you should choose if you want to send the variant by post.

Full screen
The full screen layout presents your variant in maximum size on a DIN A4 sheet.

Mark the “Letter” or “Full screen” mode in the right-hand area of the window and enter the required
address data of the recipient (the address data will only appear if the letter layout is selected). In
addition, you can compose a brief explanatory text about the colour design.

List of materials
The list of materials is added to the layout by default, but can be deselected by removing the tick.

Embed personal logo

You can personalise your variant by embedding your own logo in the letterhead. To do so, click
“Browse” and select your logo (as a jpeg, tiff or png file) from your PC or an external storage medium.
The desired logo can then be seen in the preview of the “Embed personal logo” window. Click
“Delete logo” to remove it from SPECTRUM.

When you click “Print”, a PDF document is generated, which you can save and/or print out as
needed.

Note: Please note that the colours may deviate from the original colour, depending on the printer and
paper used.

44



SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/ PHOTOstudio

Print

When you click the “Print” button, the print dialogue window of your computer opens. Choose the
printer and print settings you require for the printout. The variant will then be printed as an image
without text and logo.

PRINTservice
PRINTA

The PRINTservice lets you print your variant in true colours for a fee. When you click the button, you
go to the login screen of SPECTRUM_cloud, where you can use the PRINTservice easily.
(Registration: see chapter 9.1, “Login/registration”; PRINTservice see chapter 9.3.2, “PRINTservice”.)
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5.1.4 Forward/Back

In design mode, you can use the “Undo” and “Redo” arrow buttons to return to the last design view.

5.1.5 View buttons

Zoom in

Use this button to zoom in to the image in the workspace.
Alternatively, you can also use the “scroll wheel” on the mouse.

Zoom out

Use this button to zoom out of the image in the workspace.
Alternatively, you can also use the “scroll wheel” on the mouse.

Fit to screen

You can adapt the size of your image to fit the workspace with the aid of this button.
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5.1.6 Rocket mode

In “Rocket mode”, you can create a selection without having to set masking points with the “Create
Area” tool. This selection can be filled with a colour immediately and serves as a decision-making aid
in design work.

You can design a maximum of 3 areas in rocket mode. If you want to create more objects, show the
object list. In this case, confirm the notification that you are leaving the “Express mode”. You can
now create additional areas using the tools in the “Prepare”/“Area” tab.

Note: All tools in Express mode are also available in the “Prepare”/“Area” tab.

Note: A description of the available tools in Express mode is provided in chapter 5.3.1, “Tools: Area”.

5.1.7 Help

The “Display help” button displays the online version of the SPECTRUM 5 user manual (active
Internet connection required).

Alternatively, you can also choose “Help”/“Online help”. The shortcut command for the help function
is “F1”.

5.1.8 Show/hide object list

You can display and mask out the list by clicking the "Display objects" button.

For library images, the object list contains all the objects which you can design with colours or
materials.

In your own projects, you can create and define these objects yourself.

For more information, see chapter 5.2, “Object list” tab.
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5.2 “Object list” tab

5.2.1 Create/remove object list

To be able to design a facade or interior using different colours and materials, individual objects have
to be defined. To do so, click the “Show/hide object list” button to display the object list in the menu
bar.

e ven_ e a1 S
BE@l«=EE@ - :

Create object

To create a new object, click the “+” button. A new level is created in the tab.

You can double-click the object to rename it (see chapter 5.2.2, “Object properties™).

Delete object

=

Select an object in the list and then click the “-” icon in the tab. If you confirm the prompt with “Yes”,
the object is irrevocably deleted.
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5.2.2 Object properties

)

You can display the object properties of an active object with the gear icon or by right-clicking or
double-clicking the name of an object.

Object properties E x|
Object name
[ Facade A ]

@ Decolour object
@ Move object up

@ Move object down
@ Show material details

— % | Copy material to favouriteslist

Material-rotation

@ 0o O 450 O 90° O 1350
O

Name object
Enter an appropriate name under “Object name” (such as Ceiling, Left wall, Base etc.) and click
“Save” to confirm.

Decolour object
Click “X” for “Decolour object” and then click “Save”.

Move object up

Here you can move the component level up. The levels underneath are then covered. If the
component has already been assigned a colour/material, it is removed when the component is
moved.

Move object down

Here you can move the component level down. The levels underneath then cover this level. If this
component has already been assigned a colour/material, it is removed when the component is
moved.

Show material details
Choose “Show material details” if you want to display detailed information on the colour hue or
material of the object. (See chapter 4.3.1, “Colour and material selection”.)

Copy material to favourites list
The colour or material is added to the currently selected list of favourites.

Material rotation
When you use materials, you can change their rotation in 45° increments (for example, the direction
in which wooden floors are laid).
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5.2.3 Brightness / contrast of objects / ColorChecker

You can use the “Object brightness” and “Object contrast” trackbars in the lower area of the object
list to adjust the areas of the individual objects to portray the colours and materials as precisely as

possible. The best way to configure this setting is to use the five test colours of the “Prepare” tab
(see chapter 5.3.1. “Tools: Area”).

Object contrast

: (=]
Object brightness

I 1

ColorChecker

.

The “Object brightness” trackbar allows you to adapt the brightness of areas of your image with
different exposures (e.g., facade areas in full sunshine or wall areas in deep shadow in rooms). During
design work, the colours used are then correct when the test colour in the image has the same
brightness as in the small test colour field.

You can use the “Object contrast” trackbar to change the contrast of areas (e.g., for diffuse image
areas).

Changes to brightness and contrast trackbars are always related to the areas of the object currently
selected.

Note: Changes to brightness and contrast directly affect the colours and materials within the objects
- but not the original image.

ColorChecker

With this function you can check the brightness/contrast settings directly against the original colour. To
do this, activate a component level in the object list and then set the tick in the ColorChecker. A
rectangle with the original colour is placed over the image. With the right mouse key pressed you can
move the colour in the image to the ColorChecker rectangle.

If necessary, you can adjust the brightness/contrast control until the colours match.

[@Prorostodo

@ - EINE g . - 5

Prepare. Design

=

Collections

i

(=) < INNANARY | o

Onefamily housa 21
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5.3 “Prepare” tab

Edit images and prepare them for design

When you upload a new image to SPECTRUM 5, you first have to prepare it for subsequent design.
To do so, you can retouch the image as necessary, and have to define objects and areas for the
colours and grids for material design. (Import image: see chapter 5.1.1, “Open project”.)

You can also modify library images: you can use the tools to change existing objects and add new
objects to them.

The PHOTOstudlo tools are contained in the “Prepare” tab.

‘@f‘ 1.) 5.3.1 Tools: Area

2.)5.3.2 Tools: Grid

g 3.) 5.3.3 Tools: Retouch

5.3.1 Tools: Area

To create an area, an object must be active in the object list. The area is then assigned to the active
object. (Objects: see chapter 5.2, “Object list” tab.)

Add areas to objects

The “Area” tool defines an area for subsequent design with colour and material. Any number of areas
can be created within an object. They are given the same colour or material assignment during
design.

You can assign a colour to the object by masking it with the “Area” tool. If materials are to be added
to the design as well (e.g., spatula techniques, wood, tiles, ...), a “Grid” is necessary in addition to the
area for reasons of perspective. (See chapter 5.3.2, “Tools: grid”.)

Note: A grid can only be created where an area is already available.
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Create area

To create a new area within an object, first select the appropriate object in the object list. Then click
the “Create Area” tool. Begin by defining corner points for your area through mouse clicks - the tool
automatically connects up the points you set.

To close the area, double-click the starting point for your area when setting the last point with the
mouse. (The area has been closed correctly when the line for preparing areas no longer follows the
mouse pointer.) Alternatively, you can close the area automatically by double-clicking the next to last
point.

Note: If you would like to remove individual points during creation of an area, click the “Backspace”
button on your keyboard. The point created last is deleted with each respective click. You can then
continue completing the area.

After closing one area, you can define further areas within the same object in the same way. To do
this, click the “Create Area” tool again and define your area as described above.

Note: Please note that all areas within an object are assigned the same colour and materials during
design.

If you want to cut a polygon out of an existing area, e.g., allow for a window in a fagade, create a new
area within the existing area using “Create Area”. The intersection of the areas is cut out.
Use a test colour to test the result.

Move points/lines

Once you have created an area, you can optimise its position by moving points and/or lines, adding
new points or deleting existing points.

Note: The “Move” tool is automatically selected after an area has been created.

Move individual points by selecting the “Move” tool, clicking a point (active points are red, inactive
points are green) and dragging this to the position you require while keeping the left-hand mouse
button pressed.

Move individual lines by selecting the “Move” tool, clicking a line and drag it with the mouse to the
desired location (non-selected lines are blue, selected lines are yellow; the two points adjacent to the
line are red). The line end points are moved in parallel and the adjacent lines distorted accordingly.
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To move all the areas within an object, click the image outside the polygons to deactivate all areas.
Press the “A” key on your keyboard “to select all” and then hold down the left mouse button and
“Ctrl” key when moving the mouse.

Add points

When you activate the “Add point” tool and then click a line within an area with the mouse pointer, a
new point is set at this spot. You can see that you are on the line with the mouse pointer because it
turns white. You can position the newly created points using the “Move” tool.

Delete points/lines

Activate the “Delete point” tool to remove individual points. When you then click a point, it is deleted
immediately. The area remains closed since the adjacent points and/or lines are connected
automatically.

Alternatively, you can remove individual points and lines within an area by marking the required
points and/or lines (active points are red, active lines are yellow) and then pressing the “Del” key on
your keyboard. The respective selection is removed immediately and adjacent points and/or lines are
connected automatically - the area remains closed.

Note: You can open a closed area again by using the “Delete point” tool to click the start/end point.
This point is displayed larger than the other points.

The line to create the area begins following the cursor again; you can now create additional points or
delete points with the “Backspace” key.

Delete area

To delete an area, choose the “Delete area” tool and click a line/point on the area you want to
remove. The required area is deleted when you confirm your selection by clicking “Yes”.
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Create area with magic roll
) (<
The “Magic roll” lets you create a selection without having to set masking points with the “Create

Area” tool. The resulting selection can only be filled with a colour. If you want to use a material, you
also need a grid (see chapter 5.3.2, “Tools: Grid”).

The magic roll recognises edges in the image and selects areas that are bordered by these edges.
This tool is well-suited to rapid visualisation when the image contains large areas.

Magic roll +

The “Magic roll +” tool recognises edges in the image automatically. To make a selection, click a
point within your area you want to select. The magic roll automatically selects the area around that
point up to the edge of an adjacent area. If you click the image again, the areas are added
automatically.

Note: The “Draw mask” tool can be used to correct unclean areas or for to enlarge your selection
manually.

Magic roll -
You can use the “Magic roll -” tool to delete a previously defined selection. To do so, click the area
you want to remove. If you want to remove additional areas, click again.

Note: Selection areas can also be removed with the “Eraser” tool.

Brush

>
The “Brush” tool lets you draw a free area, which creates a selection. You can create the selection
freehand, extend a selection previously made with the magic wand or magic roll, or correct unclean

selection areas.

Note: To create a straight line, set the starting point with the left mouse button. Then press and hold
the “Shift” key while setting the desired end point with the mouse. A straight line is drawn
automatically between the two points.

Tool tip sizes

e ([0 (@

There are four differently sized tool tip sizes available in sizes 8, 16, 32 and 64 pixels for use with the
“Eraser” and “Brush” tools.

N\

/
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Eraser

&

Selection areas which you have created with the “Magic roll”, “Magic wand” and/or “Brush” tools can
also be removed. To do this, select the “Eraser” tool and correct your mask accordingly.

Magic wand +

[3\'*'] Zauberstab + | 15 ,

You can use the “Magic wand” tool to define a selection within an active area, for example, if you
want to leave out a tree in front of a fagade.

A numeric value from 0-99 regulates the sensitivity with which the magic wand automatically
recognises similar colour nuances. This value is set to 15 by default. The lower the numeric value, the
more sensitive the magic wand reacts to similar colour nuances and the selected colour area is
restricted.

To make a selection, click a point within your area which is to be included in the selection. The magic
wand automatically marks all the parts of the area with a similar brightness (depending on the
brightness setting). If you click the image again, the areas are added automatically.

Note: The “Draw mask” tool can be used to correct unclean areas or for the manual enlargement of
your selection.

Magic wand -

)

The “Magic wand -” tool lets you subtract an area from the current selection.

Note: Selection areas can also be removed with the “Eraser” tool.

Delete mask

\ /

This function can be used to completely remove selection areas within the object which you created
with the “Magic roll”, “Magic wand” and/or “Brush” tools.
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Test colours for areas

[Decolour X ]

S

An area can be filled with a test colour to see if it has been correctly defined. There are five test
colours (magenta, cyan, red, orange, green) available for this. Thanks to colour differentiation with
different test colours per object, better orientation can be achieved in the image.

Select the object concerned and then one of the test colours. All the areas belonging to this object
are assigned the selected colour.

If you change the size of the area after you have added a test colour, your corrections are not
updated until you click the test colour field again. To remove the test colour, click the “X” beneath the
test colour fields.

Note: The test colour in the image should appear identically to the test colour screen on the left. If
the test colour appears darker in the image (for example, if the wall is not white in the original image),
then correct the brightness with the trackbar in the object list on the right-hand side. This is very
important to prevent the colours used later for design being too bright or too dark. (See chapter
5.2.3, “Brightness/contrast of objects”.)

Note: The test colours are overwritten during design and are no longer visible.
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5.3.2 Tools: Grid

Add grids to objects

To ensure that an object is displayed with the correct perspective and scale not only with colour, but
also with materials (e.g., spatula techniques, fabrics, carpets, tiles, ...) during design work, a grid is
required in addition to the area. The grid is superimposed directly on the area as a reference and
provides information about the size and type of perspective distortion for the respective object.

Note: To create a grid, at least one area must exist within an object (see chapter 5.3.1, “Tools: Area”).

Create grid

To create a grid, first select the respective object in the object list. Then proceed as follows:

1. Click the “Create grid” tool.

2. You are now automatically in “Move” mode and can drag the corner points of the grid into
the required positions.

3. Enter the most realistic dimensions possible for your grid area (see “Adjust grid dimensions”).
4. Then use a test pattern to check your grid.

Note: Always create your grid slightly larger than the actual area so that your material will be visible
over the whole area of your object.

Note: Only one grid can be created per object. Therefore, you should make sure that all the object
areas are on the same perspective level. If wall areas have different perspective distortion, create a
separate object — with area and grid — for each area.
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Curve grid

\ /

You need the curve grid for materials which are to be laid around columns or curved walls.

1. Click the “Curve grid” tool.

2. You are now automatically in “Move” mode and can drag the corner points of the grid into
the required positions.

3. To curve the grid, click the lines (not the points) of the grid and drag them in the direction
you want, keeping the left mouse button pressed.

4. Enter the most realistic possible dimensions for your grid area (see “Adjust grid
dimensions”).

5. Then use a test pattern to check your “curve grid”.

Corner gid -
) (19 U7

You need the corner grid for materials which are to be laid around corner pillars or wall corners.

1. Click the “Corner grid” tool.
You are now automatically in “Move” mode and can drag the corner points of the grid into
the required positions.

3. Choose “Add line” to add an edge line to the grid. To do so, click the respective position on
the upper or lower boundary line of the grid. A line with two end points is added.

4. The “Move” tool is activated automatically. Press and hold the left mouse button and drag
the new points to the desired position.

5. When entering the dimensions, take all areas into account and enter the most realistic
dimensions possible (see “Adjust grid dimensions”).

6. Then use a test pattern to check your “corner grid”.

Note: To delete a line, click the “Delete line” symbol and then click the line in the grid you want to
remove.

Note: To continue the grid around several corners, repeat the line insertion step above.

Move

)

/

Move the grid into the right position and perspective by selecting the “Move” tool and dragging the
corner points or outer lines of the grid to the required position with the left mouse button pressed.
Reference lines are used as support for the creation of the grid with the correct perspective; they will
help show you the current vanishing point of the grid.
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Delete grid

To delete a grid that has been created, click the “Delete grid” symbol and confirm deletion by clicking
“Yes” in the dialogue window that opens.

Adjust grid dimensions

350 cm Width

250 cm Height

To ensure that the materials you add during design are represented as realistically as possible in
terms of size dimensions, the grid has to be assigned the dimensions that correspond to the original
object area. To do so, change the default size setting from width 350cm x height 250cm to the actual
dimensions. An indication of the correct takeover of the new dimensions is a grid check on the basis
of a test pattern.

Test pattern for grids

(Testcolours
Testpattern
S [ Decolour X ]

In order to check whether the grid has the correct perspective and dimensions for later material
design, you can assign it a temporary test pattern.

The chequerboard pattern is displayed larger or smaller depending on the entered dimensions (grid
width and height).

Important: If the test pattern does not display squares, the proportions of the dimensions you
entered are incorrect. To improve the aspect ratio, correct the values of the grid dimensions and click
the “Test pattern” button again to check it. If you keep incorrect dimensions, the material used for
design (wallpaper, spatula technique...) will not be displayed realistically.

To remove the test colour, click the “Decolour” button.

Note: The test pattern is only for fine adjustment of your grid for later material application - it is not
visible in the actual image during design.
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5.3.3 Tools: Retouch

The PHOTOstudlio retouch functions allow you to correct your image. It can be used to remove graffiti,
clean dirty fagade areas or duplicate construction elements, for example. Before you start retouching
work, make sure you have defined areas for your objects (see chapter 5.3.1, “Tools: Area” for information
on defining areas). Several different tools are available for retouching your image:

Entire picture

Retouching is possible in the entire image or within individual objects. To retouch the whole image,
tick the “Entire picture” field. To retouch individual objects, deactivate the field and select the
corresponding object in the object list on the right.

Brush

(&

The brush is ideal for soft contours, e.g., as shadow lines. To select a colour for the brush, click the
small colour field next to the brush. A ColorPicker appears where you can enter an HSB or RGB value
or select a colour from the range manually. Click “OK” to confirm your selected colour.

For an efficient use of the brush you can choose different brush tips under “Tool tip sizes”. Small tool
tip sizes are particularly suitable for reinforcing lines by contour drawing. The large tool tip sizes let
you fill in areas quickly.

If the pipette is used to take a sample from the picture, the brush can be used for optimum
retouching in the same spot. The brush can be used for freehand colouring in the selected area.
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Pipette

N

~

The pipette samples colour from the picture so that it can be applied with the brush. Select the
“Pipette” icon and click the desired spot in the image. The sampled colour will then appear in the
colour field next to the brush. You can use the brush to retouch the image with the sampled colour.

Note: Choose smaller or larger tool tip sizes, as needed, for exact retouching (see “Tool tip sizes” in
this chapter) and use the zoom function if necessary (see chapter 5.1.5, “View buttons”).

Stamp

i

\ /

Using the stamp tool, you can copy a section of the image and assign it to another part of the image.
You can copy windows and insert them in a different place, for example, or replace dirty or
“unattractive” image areas with clean ones.

1. To define a source point, press and hold the “Ctrl” key until white cross-hairs appear.
Continue to hold the “Ctrl” key and click the left mouse button. This spot in the image is now
the starting point for the copy operation. Release the “Ctrl” key and the mouse button.

2. Now move the cursor to the target spot in the image. Click the left mouse button (but do not
press the “Ctrl” key) - the content is copied from the source point (blue circle) to the desired
spot, the target point (green circle). Click the mouse further over the target area until you have
copied the desired area from the source spot. You can also drag the mouse over the target
area. The distance between the source point and the first click on the target point remains the
same during the entire copy operation.

Note: You can achieve good retouch results by using several clicks and/or several source points.

Pattern

The “Pattern” tool is used to adopt pattern structures in an area. To do so, click the colour field next
to the “Pattern” symbol and select one of the eight patterns from the selection window that appear —
for example, grass, sky, gravel or asphalt. Draw the pattern directly into the selected object area - it

is filled with the pattern.

Using the "Load..." button at the lower left, you can import your own pattern and fill in the selected

area with it.
The minimum size of a pattern must be 1920 x 1440 pixels.
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Gradient

{j} Gradient E

You can create light-dark gradients on an area using the “Gradient” tool. This is helpful in covering
interfering objects, large-scale soiling or conspicuous structures (bare brickwork etc.). Activate the
object in question, click “Gradient” and choose one of the ten gradient variants offered in the window
that opens.

You also have the option of applying a texture to the gradient. There are three texture levels
available.

When making your choice, heed the simulation of different light conditions so that as realistic an
impression as possible is created.

In addition, you can use the trackbar to change the intensity of the gradient. Move the trackbar and
click the previously selected gradient again to confirm the intensity adjustment. If you want to use the
intensity together with the gradient, click “OK” to confirm the selection.

Tool tip sizes

e [J(e](o (@

There are four differently sized tool tip sizes available in sizes 8, 16, 32 and 64 pixels for optimum use
of the “Brush” and “Stamp” tools.

Reset

X

Select “Reset” to undo all retouching work you have performed in your image.

Shadow gradient

The “Shadow gradient” tools allow you create your own shadow gradients for specific lighting
situations for your rooms and fagades.

Note: A shadow gradient can only be created when a defined area is available.

Create

o)

To create a new shadow gradient, click the “Create” button and enter a unique name in the dialogue
window. Then click “OK” - the newly created shadow gradient appears in the list.

In addition, a grid will appear in your workspace which you can position anywhere in the image. It
provides the shape for the shadow gradient. Move the grid points and lines to the required position.

All the shadows created are listed by name in the field below - where they can be selected and then
changed or deleted.
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Delete

[=]

If you would like to remove a certain shadow gradient, choose the respective gradient from the list
and click the “Delete” button. The selected gradient is removed from the list and deleted from the
image.

Apply

i8]

To apply the shadow gradient, click the “OK” button (“Apply”) - the shadow is intensified (becomes
darker) by clicking the “OK-Apply” button several times.
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5.4 “Design” tab

Design images

As soon as all the areas and grids have been created for all the required objects of your own image,
you can start design work in PHOTOstudio.

You can always switch between the “Prepare” and “Design” tabs.

5.4.1 Collections

de View Stido Extras  Help

EREIION |[¢) [6) (&

The “Collections” field is available for the selection of a colour or material collection. In addition to the
Caparol colour and material collections, you can also use the collections you have created in the
EXPLORER and sample material and collections from our partner manufacturers.

Collections

[ w? Collections 1

[t Favourites J

Select collection
First select the “Collections” field. The “3D-System plus” collection is selected by default in the field
below. Click this field to display the overview of all manufacturers and their collections.

[3D—Svstem plus 3 ]

[Product iter x

First select the desired manufacturer in the upper selection field. A list of all collections from the
selected manufacturer appears in the selection field beneath it. When you click a manufacturer's
collection to select it, all colours in this collection are displayed in the ColorPicker beneath it.
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"Colour" icon

The filled-in, black square before a collection indicates that this collection is a pure colour collection
without materials.

"Texture" icon

#

The mesh before a collection indicates that this collection is a collection with materials, possibly
combined with colours.

Note: The profiles of manufacturer NMC and the Melapor modules have special handling under the
collections. They are described separately in chapter 5.4.3, “3D objects: CapaCoustic Melapor

& NMC”.

Design

Collections

I

& Caparol

M 3D-System plus
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ColorPicker

Directly beneath the collection display field, you see the ColorPicker, in which you can select the
colours and/or materials to design your image.

1) Product filter

2) Colour trackbar

3) Product details

4) Number of pages

5) Lightness value

— 6) Full-text search

7) Colour preview/colour selection

Product filter

You can use the product filter to limit your selection to a certain basic material. You are then only
shown the colours that can be produced in this product.

If you want to cancel the filter for a product, choose “(No product)” in the list.

Colour trackbar

You can navigate through the currently selected colour selection using the colour trackbar. Click the
respective point within the colour spectrum shown to select a colour range (red, yellow, green...) or
move through the collection by dragging the trackbar with the left mouse button pressed. When you
click the arrow keys, the colour selection jumps to the next colour kit.
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Display product details

4

Click the “i” button to display information about the name and additional details of a product.
Alternatively, you can also double-click the colour/material to open its detail window. (See chapter
4.3.1, “Colour and material selection”.)

Search by page number in original kit

[D 162 [0 - 1000]

[D 162 /227 x]

To select a specific page of the original colour/product kit of the selected collection, click the icon
with the page number. An input field appears where you can enter the desired page humber of the
collection kit. The colour field display jumps to the given page when you click the “Enter” key.

Lightness value

(D 162] [0 -100@®

The lightness value filter lets you restrict the colours of the selected collection to a specific range.
Click the lightness value icon and enter the minimum and/or maximum values in the fields, or use the
arrow keys to move the trackbar to the desired values. The colours that lie outside the configured
range are hidden automatically. This is helpful, for example, when a lightness value of 20 should be
the minimum limit for facades with heat insulation for technical reasons. Click “X” to close the field.
All changes made so far are retained.

Note:

Set the values in the lightness limits to “0” and “100” again to have all the colour fields of a collection
shown.
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Full-text search

To search for a specific colour name within a collection, enter the name in the search field and press
“Enter” to confirm.

If you enter “Ginster 110”, for example, only the colour hue is displayed; if you enter only “Ginster”,
all colours from the “Ginster” colour family are displayed. Click the “X” at the top right edge to return
to the colour selection window.

Colour preview/colour selection

When you move the mouse pointer over the individual colour fields, the pattern the mouse is currently
on is shown in a small preview window. This function permits you to compare two samples. As soon as
you have selected a colour or material pattern with a single click, it fills the selection window.

The currently selected pattern can now be used to design an area.

Colour selection

Colour preview
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Apply CONCEPT

With the Concept design fans you have the possibility of automatically transferring a complete harmony
to a facade or interior room in the library. The main and accentuated walls as well as other components
such as plinths or skirting boards are taken into account here. Select an appropriate harmony in the
Concept fan and click on the "Apply CONCEPT" button. The colours are transferred to the library
picture.

You can change the arrangement of the colours in the picture with the dice function. Each click on the
"Dice" button changes the colour assignment. The assignment to the individual components is no
longer taken into account. It might occur that an enamel colour is assigned to the facade by the dice.

Note: The "Apply CONCEPT" button only functions with a library picture.

Note: The following collections have an "Apply CONCEPT" button: 3D plus - Concept Exterior, 3D plus
- Concept Interior and Facade A1 CONCEPT.

P cotiections
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5.4.2 Favourites

%  Favourites

To use a colour hue or material from your favourites, first click the mouse on the “Favourites”
selection field. Now click one of your sets of favourites in the field beneath it in the “Favourites” tab.
The contents of the selected favourites list appear beneath the selection field.

When you click a sample, it is highlighted with a white frame and is selected for use in the image.
(Create favourites: see chapter 4.5, “Favourites™.)

Note: Colours and materials can be used for both interior and external areas in PHOTOstudio. Please
check the technical notes to make sure the material you selected also suits the purpose in practice.
To display them, select the “i” button for a selected material. (See chapter 4.3.1, “Colour and material
selection”.)

Design

%  Favourites

™y
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5.4.3 3D objects: CapaCoustic Melapor & NMC

PHOTOstudio

SPECTRUM 5 also lets you integrate NMC profiles — that is, cornices, rosettes and acoustics elements
for interiors — in your image. They then appear as independent objects in the image and can be

designed.
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Select profile

To include a profile or acoustics element, first open the “Design” tab in PHOTOstudio and select
“Collections”. From the list, click Caparol > CaparCoustic Melapor, or select “NMC” under
Manufacturers and select the corresponding collection.

You see a set of images of the acoustics elements/profiles contained therein, which you can display in
two different view sizes. You can choose between “Show small preview images” and “Show large
preview images” to display the profile images. The small view is the default setting. In the larger view,
you can also see the names of the surfaces and the product details.

Double-click the profile image to select a profile.

Show product details

&

To display information about the name and other details of an acoustics element/profile, along with a
larger display, select a favourite card and click the “i” button. (See chapter 4.3.1, “Colour and
material selection”.)
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Placing
When you place an acoustics element/profile in the image, a preview window opens with the object
initially in the centre of the image. You now have the following options:

Scale

“Scaling” of the acoustics element/profile lets you adjust it to the size dimensions of your image. To do
s0, use the “Scale” icon. Then drag the “Scale axes” trackbar to the right to shrink the acoustics
element/profile or to the left to expand it.

Move

Select the “Move” button to move the acoustics element or profile to then correct position in the image
— the corner of the room. Use the “Move object hor.” trackbar to move the acoustics element/profile
from left to right in the room. Use the “Move object vert.” trackbar to move the acoustics
element/profile upward or downward in the image. The blue and red profile axes, along with the vertical
green centre axis, help your orientation.

Rotate

To turn the profile to the correct position between the two adjacent walls within the image, choose
“Rotate”. Use the “Rotate axes hor.” trackbar to swing the acoustics element/profile from left to right
and “Rotate axes vert.” to tip it up or down.
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Set Position
Lastly, use the “Set Position” trackbar to move the individual acoustics elements/profile axes to the

correct position. Use “Position axes hor.” to move the right side of the profile and “Position axes vert.”
to move the left side of the profile.

Accept

To use the settings for the acoustics element/profile, click “Accept”. The acoustics element/profile is
placed in the image and the “Placing” window closes.
A new object for a colour assignment is created automatically in the object list.

Duplicate

)

You can use the “Duplicate” button to place another acoustics element/profile with the same settings
directly in the image - the edit window remains open to allow you to position the duplicated acoustics
element/profile again.

Note: If you want to delete an acoustics element/profile, first go to the “Prepare” tab. Select “Retouch”
and then click the “Reset” button.

You can then use the “-” button to delete the object from the object list.

Note that if you have performed other retouching work, that work is also deleted.
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5.4.4 Copy colours/materials in the object list

Irrespective of the open ColorPicker you have the possibility of copying a colour or material in the
object list from one object to another. This means that you can colour another component with the
same colour without having to find and open the appropriate collection and the colour in the
ColorPicker.

To do this, click on the component level, the colour of which you would like to transfer to another
component.

Here, the cursor must not be located on the square preview window. Position the mouse cursor on the
component name, hold the mouse key pressed and then move the mouse onto the desired component.
Then release the mouse key. The colour or the material is copied and the associated areas in the
picture are coloured correspondingly.

Garage
Moos 85
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5.4.5 Multiview pictures

Some library pictures are "Multiview" pictures, i.e. there are various spatial views for these pictures.
This provides you with the possibility of "moving" in a room.

The various spatial views are displayed in the work space at the lower right.

A click on a different view displays this new view.

Your colour design is always updated in all views. For example, if you design the wall A in view 1 with
the colour May 5, then in view 2 the wall A is also assigned the colour May 5.

Note: You can always only save one view and this is the one which is currently loaded into the work
space. All the other views and colours, which only appear in these other views, are discarded. The
saved picture is then no longer a "Multiview" picture.
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6. 3Dstudio

The new 3Dstudio lets you import data created in Google Sketchup and select the levels to colour,
the image view and the camera position. Sketchup is a 3D visualisation program that lets you create
virtual objects free of charge (http://www.sketchup.com) or use them from the 3D gallery
(http://sketchup.google.com/3dwarehouse/search?tags=3D+Objekte), also free of charge. The saved
data are then used for design in PHOTOstudio, including the corresponding objects.

=l0lx)

iy

6.1 Menu bar

The menu bar contains several different options.

p Original ]@ Edges }{"9 SPECTRUM-import ]‘[7’7' = Close 3Dstudio ] 123

Open project

=

To upload a 3D file created in Google Sketchup or Roomdesigner
(http://www.egger.com/DE_de/roomdesigner.htm), click the “Open project” button. A window opens
in which you can select the corresponding file on your computer. Then click “Open” (alternative: main
navigation “File” > “Open”). The file is opened in 3Dstudio.

Save

To use a Sketchup file for design work, the file must be saved. The saved image is then loaded into
PHOTOstudio for design work.

To save, click the “Floppy disc” icon. A window opens to display the projects in EXPLORER. Select
the desired target folder in your own projects or create a new project folder (see chapter 4.2.2, “Own
projects”), then enter a name for the 3D file and click “Save”.
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Close 3Dstudio

[ Close 3Dstudio J

If you want to return to the other program modules, click the
“Close 3D studio” button at the top of the menu bar. 3Dstudio is closed and SPECTRUM 5 opens
with the last active module view.

Help

)

The “Display help” button displays the online version of the SPECTRUM 5 user manual (active
Internet connection required).

Alternatively, you can also choose “Help”/“Online help”. The shortcut command for the help function
is “F1”.

Views

When you open a 3D obiject, all the corresponding “Objects” related to the object in the menu on the
left, below the “Original”, “Edges” and “SPECTRUM import” tabs. You can click the individual
objects to display or hide them for the subsequent design file. Objects with a white frame are
displayed in the image; objects without a white frame are not visible later. The three tabs above the
object let you change the view of the file.

[é Original ]@ Edges ]E’Q SPECTRUM-import ]

“Original” view
In this view, you see the original version of the 3D file — like you created it originally in the other
program. Displayed objects appear here in red; hidden objects are grey.

“Edges” view
In this view, you see the objects in a transparent impression. The background of the work area
appears in red. Displayed objects appear here in grey; hidden objects are not visible.

“SPECTRUM import” view

In the “SPECTRUM import” view, you see both the transparent structures of the hidden objects in
grey and the displayed objects in red.
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6.2 Camera settings

e

|\/|_O\_/e camera
1=

Using the slide control, you can move the camera upwards and downwards.

Camera angle
=

You can change the angle of the camera with the associated slide control.

Zoom

For zooming in and out on the image section move the slide control below the black position field.

Position

In the black position field you can change the location (green square) and camera position (red
square).

To change the location click on the green square with the right mouse key and move it to the
appropriate point.

You change the camera position by clicking on the red square with the left mouse key and moving it to
another position.
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7. MATERIALstudio

In MATERIALstudio, backgrounds with different coatings and surface techniques can be put together
to form your own sample combinations. These can be saved and then used like all other colour hues
and materials in SPECTRUM 5 for design purposes in PHOTOstudio, as well as exported to other
programs.
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7.1 Menu bar

The menu bar of MATERIALstudio contains the following options, depending on which tab is
currently open:

@ Change symbol sizes
|

Change symbol sizes

i)

You can choose from five different views to display the backgrounds. (See chapter 4.1.1, “Data
views”.)

Save
=

To save an individually created sample, click the “Save” button (or choose “File”>“Save as” in the
main navigation). A window opens that gives you an overview of your own collections. Select an
existing collection or create a new collection folder (new collection: see chapter 4.3.2, “own
collections”). Enter a unique variant name (e.g., FF_Tira_Pink 10 (for Fantastic Fleece_Design
Tira_Colour 3D Pink 10) and confirm by clicking “Save”.
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Print

If you would like to print your individual sample for viewing purposes or for a collage,

click the “Print” button. The program creates a PDF file in DIN A4 size to display both the structure of
your coating and the finished design of the pattern. You can then print or save the PDF file. This
function is also available in the main navigation under “File”>"Print”>“PDF”.

Note: Please note that the colours may deviate from the original, depending on the printer and paper
used. We recommend that you create a sample area. In addition, colour sheets can be ordered from
Caparol for Caparol 3D system plus and CaparolColor.

2)

/

The “Display help” button displays the online version of the SPECTRUM 5 user manual (active
Internet connection required).

Alternatively, you can also choose “Help”/“Online help”. The shortcut command for the help function
is “F17.
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7.2 Create individual samples

When creating an individual material sample, choose a surface first and then coat it according to your
needs, using the products available in the collection.
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7.2.1 “Background” tab

Interior or Exterior

Decide first whether the background you require is to be used for the interior or fagade area, and
select the “Interior” or “Exterior” field accordingly. The list of available backgrounds changes
automatically to match your selection.

In the next step, choose a background. Double-click the thumbnail pattern to load a background. The
structure fills the workspace and the tab automatically changes to “Collection”.

Note: If you want to choose a different background, click the “Background” tab again. The enlarged
display and existing design of your background are retained until you double-click the sample image
of a different background. Material combinations that have not been saved are lost at this point.
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7.2.2 “Coatings” tab

Once you have selected a background, you can design the pattern with an individual product and
colour selection in the “Coatings” tab.

Coating

Start with the “1. Coating” and select the product you want in the dropdown menu. Then click the
“Paint” field below the coating selection. You now see a list of all manufacturers and their collections
which are available for the selected coating. Select a manufacturer first and then select a collection in
the tab below it. The ColorPicker opens, in which you can select a colour.

Note: Only those products and/or coatings are offered that are technically feasible and
recommended. A 2nd/3rd or 4th coating can only be selected if it makes sense for this material.
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ColorPicker

You can select a colour for the coating in the ColorPicker dialogue. The sample is coloured
immediately when you click a colour field. This preview remains visible in the ColorPicker until
another colour is selected. When you click the “X” in the upper right to close the ColorPicker, you
return to the coating structure.

SIE[TRES] ~ = con e = @

As in the EXPLORER and PHOTOstudlo, the ColorPicker offers the following possibilities here, as
well: Limitation according to lightness value, page in colour kit and full-text search (see chapter 5.4.1,
“Collections”).

Note: Depending on the background chosen, only certain coating possibilities are shown in the
dropdown menu. This is because the backgrounds can only be processed with a certain type and
number of coatings. With this approach, SPECTRUM 5 ensures that your individual material
combinations are actually possible in reality.
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Change coatings

If you would like to change the colour of a coating later, click in the field below the coating and
choose a new colour. If you change the type of coating in the dropdown menu, the colour has to be
selected again as well.

Note: When you select a different colour and retain the coating type, the subsequent coatings
remain, but not their corresponding colour. If you change a coating type, however, the subsequent
coatings are reset completely.

Remove coating

After you have coated your background, you can remove the last coating layer you added. To do so,
click the “Paint” field of the coating and click the “X” icon in the upper right of the tab, instead of a
colour.

7.3 Use individual samples

All individually created and saved samples are stored in “Collections”/“Own collections”. In
PHOTOstudio, the “Design”/“Collections” tab gives you direct access to “Own Collections”. (See
chapter 4.3.2, “Own Collections”.)
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8. SHOW

You can use the “SHOW” module to put your variants, materials and colours together in a collage,
compare them and present them in a slide show. The SHOW is ideal for presenting your own range of
products at the POS or to present an overview of variant contents and advise customers accordingly.
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8.1 Menu bar

The special thing about the SHOW workspace is that you can move image data around freely within
it, like on a desktop. Images, samples or 3D views can be arranged next to one another,
superimposed or in a collage, all at the same time.
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Show collections

Select the “Kit” icon to access your collections and favourites and load your individual colours and
materials into the workspace.

Open a manufacturer's collection and use the ColorPicker to click the desired surface for the show.
Or select a set of favourites and load its contents into the show by clicking the sample image.

Note: For more information about collections and favourites, see chapter 5.4, “Design” tab.
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Open project

7 N
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Click “Open project” to load image data from your own projects or INTERIOR/EXTERIOR samples
the SHOW workspace (alternative: use “File”>“Open” in the main navigation). Select the desired
image in the dialogue window and click “Open” to confirm. You can also optionally import the colour
and material data for an image.

Open show

Click “Open show” to load an existing show project from your projects to the workspace (alternative:
“File”>"Open show” in the main navigation) or to clear the workspace. If you want to keep the show
you have put together so far, save it in your own projects first.

Click “Open show” and select the desired show project from the list of projects in the window that
opens. Click “Open” to confirm. You can also open a show by double-clicking it in EXPLORER.

Note: Image data that is greyed out cannot be loaded in SHOW.

“Clear workspace” clears the show workspace of the composition you have made so far.

Save show

(=

To save the current composition in your workspace, click the “Save” button. In the dialogue window
that opens, you can give your show project a name and save it in the desired project folder or create
a new project folder for it.

“

/

Print

Click the “Print” button to print the current arrangement of your SHOW workspace as a PDF. All
colours, materials and image data are sorted adjacently and output on one or more DIN A4 sheets.

Zoom in/zoom out

To zoom an individual image, colour or material data in or out, first click the required object (the
active object is marked by an “X” at the top right-hand corner) and then move the mouse wheel over
the object to zoom in/out, or click the respective “Magnifying glass” icon.
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Full screen

=

\ /

Full screen mode allows you to show the current arrangement of your composition as a full screen.
Menu bar, tab etc. are hidden for this purpose. Click the “Close” button to return to the workspace.

Help

2)

The “Display help” button displays the online version of the SPECTRUM 5 user manual (active
Internet connection required).

Alternatively, you can also choose “Help”/“Online help”. The shortcut command for the help function
is “F17.

Display/mask out object list

You can display and mask out the list by clicking the "Display objects" button.

All images and samples are listed in the object list.

Here, you have the possibility of deleting objects, changing the sequence and making settings for the
DiaShow.

You will find further information on this in Chap. 8.1.1 "Views".

8.1.1 Views

The SHOW module features three different views: comparison, collage and full-screen mode.

Compare

&2

To display a fast, clear comparison of selected images/variants, click the “Compare” button. All the
image data currently on the workspace are arranged in such a way that you can compare them with
one another. Objects that were behind one another are placed next to one another for this purpose.
The more image data are compared at the same time, the smaller the image size of each shown. If
the number of images is reduced by deleting individual images, click the “Compare” button again to
adjust the remaining images to their maximum display size.

Collage

The collage view is the default setting for the SHOW module. All new shows are initially used in

collage mode. In this view, you can freely move, assign, enlarge and shrink all surfaces and image
data in the workspace.
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Slide show

(v
The slide show is ideal for presenting your own variants, colours and surfaces during a meeting with
a customer or for advertising purposes on a large screen in the POS. It is particularly impressive

when the same image is shown several times in succession in different variants.

When you click this icon, all image data in the workspace is arranged in sequence. The sequence
chosen here determines the sequence of the image data during the slide show (the display runs from
front to back or from left to right). Keeping the left-hand mouse button pressed, you can drag
individual samples out of the sequence and add them again in a different place (release the mouse
button).

>
Ssconda

Click the Play button in the lower right of the object list tab to start the slide show. The images and
surfaces are displayed on the screen in full-screen mode in the defined sequence.

To pause the slide show, click anywhere in the screen. The play menu appears in the lower right and
you can click the “Pause” button to pause the show.

If you click the “Stop” button, you return to the workspace for the slide show in Spectrum. You can
also click the “Esc” key to exit the show.

Note: You can determine the time in between images yourself. To do this, enter a figure for number
of seconds in the “Interval” field. 3 seconds is the default setting here.

Delete object

m)

The object list contains a “Delete object” button.

Click a project name, colour or material in the list and then click the “Delete object” button. The
corresponding file is removed from the workspace.

Alternatively, you can select a file in the workspace and click the “X” button to delete it.

Note: The object is merely removed from the workspace, not deleted from your projects. You can
add the removed file to the workspace again at any time.
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Object properties

L)

The object properties of the object activated by clicking on it can be opened using the gearwheel

symbol.

Object properties i _)ﬂ
Object name

( ]

@ Show material details
B Move object up
E] Move object down

( ame )

Show material details
Select "Show material details" if you would like to obtain detailed information about the colour or
material of this component. (see Chapter 4.3.1 "Colour and material selection")

Move object up
Here you can move the component level up. The topmost level is always replayed first in the
DIAshow.

Move object down
Here you can move the component level down. The lowest level is always replayed last in the
DIAshow.
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9. SPECTRUM_cloud

SPECTRUM_cloud is your personal SPECTRUM data store on the Internet, where you can save show
projects and variants, download collection data and take advantage of a variety of services. The
cloud also makes it possible to exchange image data and variants between the different SPECTRUM
applications.

9.1 Log In/registration

{SPECTRUMQW

To access the cloud, click the “SPECTRUM_cloud” button in the program. An Internet connection is
required.

9.1.1 Registration

You have to register before you can use the SPECTRUM_cloud for the first time. To register, click
“Create account”: You see the registration screen. Fill in all the required fields (marked with asterisks)
and click “Register”.

You can now log in with your access data.

SPECTRUM §
PO-Softwaro

e

Note: If you already use one of the other Caparol/Spectrum portals, such as capadata_online or the
Jumbo Portal, you do not have to register again for the SPECTRUM_cloud. You can use your existing
login data from the other portal to log in to the cloud.

9.1.2Log In

If you already have a user name and password from one of the other Caparol/Spectrum portals, or
you have already registered for the cloud, enter your user name and password in the login screen and
click “Log In”.
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9.1.3 Forgot password

If you have forgotten your password, click “Forgotten your password?” in the log in screen. In the
window that appears, enter your user name or e-mail address (which you specified during
registration). Click “Send”. You automatically receive an e-mail, sent to the e-mail address you
specified during registration, with your password.

9.2 Data administration

9.2.1 Own files down-/upload

In the “Own files down-/upload” area, you can upload up to nine projects and a show to the cloud

and save them. After the upload, you can download them to SPECTRUM 5 again and edit them
further, or download them for presentation in the free of charge SPECTRUM_express application.

Show upload

To upload a show, click the ascending arrow in the “Show” tab. A window appears that displays your
projects in Spectrum 5. Select a project folder and then select the preview image of the show project
you want to upload (a SHOW project is indicated by a green “S” at the lower right edge of a variant).
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The show is uploaded to the cloud. You can track the upload status with the status bar in the cloud
screen. Once the show has been uploaded successfully, you see a preview of the workspace and
have two options for using your show project (see white bar in the lower screen area):

Variant 1: Navigate to cloud.spectrum.eu and enter the following ID:
B2BOD1

Variant 2: Copy the following link, for example into an e-mail:

{ cloud.spectrum.eu/?show_id=B2B0D1 ]

Display in SPECTRUM _express

“Variant 1” contains the corresponding SPECTRUM-ID for the project. This ID was assigned
specifically to the uploaded show. You can use it to display the SHOW in SPECTRUM_express. To
do so, open SPECTRUM_express under http://cloud.spectrum.eu and enter the ID in the field near
the bottom of the screen.

SHOW mode opens, in which all colour hues, materials and image data from the SHOW are
displayed in the browser. To close the show, click the “X” at the upper-right corner of the screen.

Send the show link via e-mail

Under “Variant 2”, you see a direct link to SPECTRUM_express, which automatically opens this
SHOW in the online application (requirement: active Internet connection). You can send this link via e-
mail, for example.

Project download/upload

To upload a project, click the ascending arrow in the project tab. A window appears that displays
your projects in Spectrum 5. Select a project folder and then select the preview image of the project
you want to upload (indicated by a blue P at the lower-right corner of the screen).

The project is uploaded to the cloud. You can track the upload status with the status bar in the cloud
screen. Once your project has been uploaded successfully, it appears in the list of uploaded projects.

To download a project from the cloud to a SPECTRUM 5 installation, click the project to select it
from the cloud's project list and click the descending arrow for “Download”. A window appears that
displays your projects in Spectrum 5. Select a target folder for your project, enter a variant name for
the project and click “Save”. The project is saved in the selected project folder in EXPLORER in
SPECTRUM 5. You can also open the project directly in PHOTOstudio for further editing optional.
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9.2.2 Download collections

In the “Manufacturer” area, you can download the latest collections from Caparol and our partner
manufacturers to your SPECTRUM 5 free of charge.

To download a manufacturer collection, first select the corresponding manufacturer. Then click the
desired manufacturer collection. You see a preview of the contained surfaces. Press the green
“DOWNLOAD” button at the upper right corner of the window. The collection is downloaded to your
SPECTRUM 5 installation. You can track the download status with the status bar in the cloud
interface.

The downloaded collection is now contained in EXPLORER, in the “Collections” tab, in the list of
available manufacturers. It can be used for design work in PHOTOstudio, like all the other collections.
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10. myMaterial-Manager

SPECTRUM 5 offers an unrivalled selection of current colours and material collections. The
“myMaterial-Manager” enables you to export all surfaces through “drag-and-drop” to external
programs such as Microsoft Word, Adobe Photoshop, InDesign and lllustrator, as well as CAD/3D
applications such as 3Dsmax, Cinema4D etc. When you click “Extras”>“myMaterial-Manager” in the
main navigation, the SPECTRUM 5 program window is closed and the “myMaterial-Manager”
window opens.

| mytHaterial Manager ____ A myHMaterial-Manager H

Return to SPECTRUM 5 Return to SPECTRUM 5

=/ (m
VP cottections b cottections
%  Favourites % Favourites

@ caparol 3D-System plus »

10 Top 10
Own collections
NCS
NMC Aretis 75
RAL
Rasch
Sample materials -l
—_— Aretiz 80
I 30-System plus _I
I 30-System
I 30 plus - Concept Ausse| 3 5 '

M 3D plus - Conceptinmen| | [  Awctses

M caparolColorSystem ‘

10.1 Structure of myMaterial-Manager
The “myMaterial-Manager” is shown as a minimised workspace that can be moved freely around
your PC desktop.

Note: SPECTRUM 5 continues to run in the background when “myMaterial-Manager” is being used
and can be recalled at any time by clicking “Return to SPECTRUM 5.0”.

10.1.1 Select colour, material and favourites

Much like the tabs in EXPLORER, the “myMaterial-Manager” gives you access to the database with
all corresponding colours and materials. To choose a colour or material, first select the respective
“Collections” or “Favourites” tab. In the respective tabs, you can refine your selection to specific
manufacturers and their collections or to specific sets of favourites (see chapter 5.4, “Design” tab).
When you click a collection, the view changes to a visual representation of the contents. You can use
the scroll bar on the right edge of the window to browse the collection.

You can choose between “Show small preview images” and “Show large preview images” to display
the colour and material images. The small display view is the default setting. In the larger display, you
can also see the names of the surfaces.

To select a different collection, click the collection hame field and you return to the selection
overview.
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10.1.2 Export colour, material and favourites

After selection of a colour/material (dark-grey frame visible) you can export it to another program with
“drag'n'drop”. Select the sample by clicking the left mouse button, then keep the button pressed and
drag the mouse into the workspace of the program the colour or material is to be exported to. When
you release the mouse button, the sample is exported to the other program.

Depending on whether you export a colour or material to the other program, the data will be available
in different resolutions:

Colours: 256x256 pixels, 72dpi
Materials: 1417x1417 pixels, 18dpi

@ H9-0%R 5 Maootword m—
S s |ty Sotomed] Vironiia) | sércungin) . Goerpdoton | Anknt L Agdonn @
‘3 4 TmesNewRoman - |12

TN B e el
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Zuwischenabiage senntant

Einfigen
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Sefte:1von1 | Worter0 Deutsch Deutschiang) |

10.1.3 Return to SPECTRUM 5

If you want to return to the full-screen view of SPECTRUM 5, click the “Return to

SPECTRUM 5” button in the upper area of the myMaterial-Manager. The myMaterial-Manager is
closed and SPECTRUM 5 opens in the EXPLORER module.
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11. Colour fidelity - Calibration - ColorMunki

For the assessment and presentation of a design at the monitor and as a hard copy print or for
presentation to customers, the so-called “colour true” to the original colour plays a decisive role.

SPECTRUM 5 provides two different possibilities for you to optimise colour presentation in your
media:

11.1 Simple colour optimisation (without ColorMunki)

The SPECTRUM 5 full version contains a “SPECTRUM calibration kit” for optimising colour
representation on the monitor. The calibration kit has 15 original samples of the Caparol 3D system
that are used as comparative samples for monitor presentation. Brightness and saturation, as well as
the individual colour channels, can all be adjusted independently.

11.1.1 Calibration

In the program’s main navigation, click “Extras”>"“Colour settings”> “without ColorMunki...”.

Note: The monitor should be switched on for at least 30 minutes for calibration to guarantee a stable
display.

The following dialogue will open: Click the “Next” button to access the monitor settings.

I — 3 | e — = x

Kalibrierung Wilkommen

Moaltor settings. Dispiay colour settings
‘Compara tha displayed colour

‘optimal brightness and Bars with the onginals in your
SPECTRUM 5 calibraion k..

5 using these test images. ‘Correct the dispiay by
Sdjustng the boghtress,

Saturaton and indvidual colour
channels.

Saturation

@14—>E
S
L

Monitor settings

Here you can check the contrast of your monitor on the basis of the two test images (white-black).
The lettering “SPECTRUM 5” should be legible in both fields. In addition, a “harmonious” even
progression from white to black should be visible in the lower gradient bar. Click “Next” to reach the
colour settings.
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Display colour settings

Compare the displayed colour bars with the originals in your SPECTRUM 5 calibration kit. Correct the
display by adjusting the brightness, saturation and individual colour channels. You can work with the
trackbars “Brightness” and “Saturation” as well as the colour trackbars for the colour channels
“Red”, “Green” and “Blue”. When you move a trackbar, the change affects all the colours displayed.
You see the change in the right-hand half of the respective colour field, the left-hand side remains as
it was for purposes of comparison.

Note: Only correct the colour channels if the grey hues shown appear reddish, bluish or yellowish.
After correction, the grey hues should be as neutral as possible - without any colour cast. Also
compare colour hues with the original samples in the calibration kit that comes with the SPECTRUM
5 program. If you want to accept your corrections to calibrate your monitor, click “Apply”. To reset
your previous settings and/or calibrate again, click “Reset”.

Note: The setting changes carried out here only have an effect within the SPECTRUM 5 program.

11.2 Calibration with ColorMunki

A ColorMunki makes it possible to create valuable profiles for output devices such as monitors and
printers. The ColorMunki spectral photometer from market leader X-Rite improves colour
reproduction in SPECTRUM 5 from the start and optimises the colour display on your monitor and
printer.

After connection of a ColorMunki, you can calibrate both monitor and printer and import colour hues
directly into the software.
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11.2.1 Display profiling

In the first step, connect the ColorMunki to a USB port on your PC. In the program’s main navigation,
click “Extras”>"Colour settings”>"“with ColorMunki SPECTRUM...”.

If the ColorMunki has been connected correctly and is active, the following dialogue opens:

& ColorMunki SPECTRUM

Datei ?

Monitor profilieren

Erstellung eines Monitorprofils zur
Verbesserung der Farbdarstellung auf
Ihrem Monitor oder Projektor.

Drucker profilieren

Erstellung eines Druckerprofils zur
Verbesserung der Farbwiedergabe Ihres
Druckers.

Click the “Profile My Display” field to select it. You are now guided through the individual steps
necessary for profiling.

Select display type
First, click the “Display Type” you want to profile. You have the choice between LCD, laptop or
projector.

Then, in the next step, decide whether you want to carry out “Easy” or “Advanced” profiling.

¢ ColorMunki SPECTRUM
Datei ?

=

1t werden, wenn der Typ richtig angegeben wurde.

’;

© Projektor

Modi zur Verfugung. Bitte wahlen

« Zuruck Weiter —>

Easy profiling

Easy profiling accesses basic settings that trigger standard profiling of the display. This setting is
suitable if you do not want to include any special settings for ambient light and luminance in the
profile.
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Advanced profiling
When advanced profiling is selected, you can measure the ambient light or set the luminance for your
pro- filing manually. In addition, you can define different types of light in the white spot area.

Choose “Set display luminance for the ambient light” if you do not require any special settings for
luminance. If you wish to set luminance manually, select “Set display luminance to this reference
value” and then set the required luminance between 80 and 140 Candela in the field on the right.

Depending on your requirements, you can specify the white spot between D50, D55, D65 (standard)
and native. Then click the “Next” button to continue profiling.

& ColorMunki SPECTRUM

Datei ?

-

Profile My Display . thr Monitor kann nur dann richtig profiliert werden, wenn der Typ richtig angegeben wurde.
Bitte wahlen Sie unten Ihren Monitortyp.

i -

© Laptop © Projektor

2. Fur die Profilierung des Gerats stehen zwei verschiedene Modi zur Verfugung. Bitte wahlen
Sie den Benutzermodus aus, den Sie verwenden mochten.

© Einfach © Erweitert

®  Leuchtdichte des Monitors fur das Umgebungslicht einstellen

» Leuchdichte des Monitors auf diesen Sollwert

120 ~
einstellen: i

Gewunschter WeiBpunkt: | D65 (Standard) ~

€ Zuriick Weiter >

ColorMunki status

In the following “ColorMunki Status” dialogue, SPECTRUM checks whether your ColorMunki is ready
for a profile to be created. If the ColorMunki has not been connected to the PC correctly, the
following dialogue appears:

ColorMunki-Status
Monitor profilieren Gerat ist nicht angeschlossen. Bitte schlieBen Sie das Gerat an.

Monito wahlon

ColorMunki. Status

Gerat anschlieBen
Gerat kalibrieren

Messposition wahlen

Kalibrieren

4" Kiicken Sie hier, um eine Videoanleitung zu sehen

€@} Startseite « Zurtick

Check the connection or connect the ColorMunki to the PC using the cable provided. As soon as the
ColorMunki has been connected correctly, an image of the ColorMunki will appear with a green tick
next to the ColorMunki image with status “Connected”.
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If the ColorMunki wheel is not in the right position for profiling the monitor, the ColorMunki image
shows an orange arrow that points to where the wheel should be moved to.

-

Monitor profieren

If the ColorMunki has been connected correctly and the ColorMunki wheel brought into the right

position, click “Calibrate” to start calibrating the monitor. If the calibration has been carried out
correctly, a green tick will appear next to “calibrated”.

& ColorMunki SPECTRUM

Datei ?

=

Monitor profilieren

ColorMunki-Status

Gerat ist angeschlossen, aber nicht zur Messung bereit. Bitte drehen Sie das Einstelirad auf die
unten dargestellte Position.
auswahlen

ColorMunki. Status

@ Angeschlossent
@) Kalibriert

Messposition wahlen
.

Klicken Sie hier, um eine Videoanleitung zu sehen

(Y Startseite

€ Zurtck

Then move the ColorMunki to the measuring position shown in the graphic. When you have set the
position correctly, a third green tick will appear indicating the correct position. Then click “Next”.

< ColorMunki SPECTRUM
Datei ?

=

Monitor profilieren

Munki-

Das Gerat ist kalibriert und zur Messung bereit. Klicken Sie auf Weiter, um fortzufahren.

@ Angeschiossen!
@) Kalibriert!
@) Position korrekt!

Kalibrieren

! Kiicken Sie hier, um eine Videoanleitung zu sehen

€} Startseite

€ Zurlick Weiter =

Note: Should you need further information about this dialogue, you can watch the related video
instructions (Internet connection required).
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Fixing ColorMunki to the display
In this dialogue, SPECTRUM shows you where ColorMunki must be placed on the display.

To avoid incident light, place the ColorMunki in the sleeve provided by the manufacturer first. Then fix
the ColorMunki in the position shown with the aid of the weight, so that the ColorMunki remains on
the display. Click “Next”.

¢ ColorMunki SPECTRUM

Datei ?

=

Profile My Display Eine Reihe von Farbfeldern wird nun
gemessen, um Gamut und Farbreaktionszeit
des Monitors zu ermitteln.

ColorMunki am Monitor
befestigen
Profil

Bitte setzen Sie zuerst Ihren Monitor auf die
Werkseinstellungen zuriick. Stecken Sie
ColorMunki dann in die Schutztasche, und
ColorMunki befestigen Sie es an Ihrem Monitor. Bitte
hier prufen Sie, ob der Boden der ColorMunki
anbringen Schutztasche offen ist.

-7 Klicken Sie hier, um eine
=1 Videoanleitung zu sehen

) Startseite < Zuriick Weiter >

Note: Should you need further information about this dialogue, you can watch the related video
instructions.

The software now outputs a series of coloured hues in different brightness on the display; these are
read by the ColorMunki.

Create profile

After the series of colours has been imported, the “Create Profile” dialogue opens. Here, the profile
created can be saved on your PC under the suggested profile name or a name you choose yourself.
To do this, click “Save”.

¢ ColorHunki SPECTRUM

Datei ?

=

Erstellung Ihres neven

uf “Speichern”, um Ihr neues Profil zu erstellen.
Profilname:

CE240W_D65.icm

Speichern

@} Stanseite

After this, you can create a “reminder date” for the new profile. Then click “Next”.
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Note: If the system has not been able to carry out the profiling process properly, the profile created
cannot be saved and you will receive a message that profiling has failed. Make sure that you have the
necessary administration and write privileges on this PC and repeat the procedure.

Comparison before/after
Here you can see the change compared with the display’s original profile.

Click “Next” and you will be back in the start dialogue of the ColorMunki menu.

Note: The profile created for your display using ColorMunki can be viewed, activated or deactivated
in your PC’s properties under “Settings”>“Advanced”>"“Colour management” (operating system-
specific).
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11.2.2 Printer profiling

If you want to ensure true-colour printouts which are not dependent on individual printer models and
to compensate for series variations, wear and tear etc., we recommend using a spectral photometer
to create individual colour profiles.

It should also be obvious that the paper and inks used are just as important to the end result.

Please understand that we cannot cover the entire printer market. We have tested individual printers,
however, and are happy to provide you with the corresponding profiles.

One printer we have found to be reliable is this one:
http://www.canon.co.uk/For_Home/Product_Finder/Printers/Professional_Photo_Printers/PIXMA_Pro
_9500_Mark_II/

We have tested the following printer papers:
e EFI CertProof Paper 6225XF Semimatt
e EFI Offset Proof Paper 9200 Semimatt
o EFI Proof Paper 5200XF Semiglossy

During our tests, it became apparent that the calibration software used is also a factor.

We are extremely satisfied with the results of ColorMunki spectral photometers and the
corresponding software from X-Rite.

The results were excellent for various printers, papers and logical settings.

The ColorMunki Photo and ColorMunki Design models are equally well-suited.

The ColorMunki SPECTRUM, which Caparol previously distributed in a bundle with the SPECTRUM
4.0 software, also works very well.

These models also let you use additional features in SPECTRUM 5 — as was also the case with
SPECTRUM 4.0.

Canon also offers calibration software for the printer, but we were not entirely satisfied with its
profiles.

In the first step, connect the ColorMunki to a functional USB port on your PC. In the program’s main
navigation, click “Extras”>“Colour settings”>“with ColorMunki...”.

If the ColorMunki has been connected correctly and is active, the following dialogue opens:

Monitor profilieren

Erstellung eines Monitorprofils zur
Verbesserung der Farbdarstellung auf
Ihrem Monitor oder Projektor.

Drucker profilieren

Erstellung eines Druckerprofils zur
Verbesserung der Farbwiedergabe Ihres
Druckers.

Click “Profile My Printer” to select it. You will now be guided step-by-step through the profiling
procedure.
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Start printer profiling

When you start printer profiling, first choose whether you want to create a new profile for a printer or
optimise the existing profile for your printer. In the next step, select the printer you want to profile.
Then specify the type of paper you use with the printer being profiled.

¢ ColorMunki SPECTRUM

Datei ?

Druckerprofilierung s

Drucker profilieren 1. Mochten Sie ein neues Druckerprofil erstellen oder machten Sie ein bestehendes ColorMunki
Profil optimieren? Die Optimierung verbessert die Farbgenauigkeit spezieller Farben.

© Neues Profil erstellen
Drucker,

© Bestehendes Profil optimieren

. Wahlen Sie den Drucker, den Sie profilieren mochten.

Brother MFC-260C Printer v

3. Sie missen fur jedes Papier, das Sie mit diesem Drucker verwenden, ein eigenes Farbprofil
erstellen.
Geben Sie den Namen des Papiers, fur das Sie ein Profil erstellen mochten, in das Textfeld ein.

(Y Starseite € Zuriick Weiter >

Note: A separate profile must be set up for each individual printer and each type of paper you use
with the respective printer, to guarantee colour fidelity during profile creation.

Then click “Next” to print so-called “Targets” (target sheets with colour field compositions for
importing) for your ColorMunki.

Print first target
Click “Print” to print the first target or, if you already have a printed target, select “l have already
printed my target”.

¢ ColorHunki SPECTRUM

Datei ?

Drucker profilieren Sie misssen mit ColorMunki zwei Farbtargets drucken und messen, um Ihren Drucker zu profilieren.

Das erste Target bietet Informationen ber alle Farbbereiche, die Ihr Drucker wiedergeben kann.

Druckerprofilierung starten

Erstes Target drucken

; ey '="

I =

[
m=m= Drucken...

Ich habe mein Target schon gedruckt.

€ Zuriick

Read the notes shown before you open the print dialogue and then click “Next”. Click the respective
settings in your print dialogue, select the required printer and then click “OK” to print the first target.

Click “Next” as soon as the target has been printed.

111



SPECTRUM Version: 5.1.00 rev/13.08.2015- http://help.spectrum5.eu/ Colour Fidelity — Calibration - ColorMunki

Allow the target to dry
In the next dialogue, the drying time required for the target is shown in a countdown. Please wait until
the timer has expired before you starting measuring the target.

Note: If you have a target that is already dry, you can skip the drying process by clicking “Skip
Drying Process”. Then click the “Next” button to continue measuring.

rHunki SPECTRUM

Farben, die mit einem Tintenstrahldrucker gedruckt wurden, andern sich wahrend des

Trockenvorgangs nvorgang ist normalerwet: 0 Minutes lem Druck
abgeschlossen. Unten sehen Sie einef or. Bitte ler Timer abgelaufen ist, ehe Sie
ein Target, das mit einem Tintenstrahldrucker gedr sen.

9:47 Verbleibende Trockenzeit

Trockenvorgang uberspringen

< Zuriick

Measure first target

Now measure the first target by applying the ColorMunki at the bottom end of the first line (before the
first colour field). Click the function button for the ColorMunki and move the line from bottom to top
as straight as possible with the button pressed. Only release the button when the ColorMunki is no
longer over the colour field. If the line has been measured correctly, the yellow frame in the display
dialogue moves to the next line.

If the line has been measured incorrectly, it will have a red frame round it. You can only measure
again when the frame appears green.

¢ ColorHunki SPECTRUM

Datei ?

Ers get messen

Messen Sie die gelb markierte Zeile. Nach erfolgreicher Messung wird die nachste Zeile markiert.
Bei fehlerhafter Messung wird die Zeile rot markiert, bis der Fehler behoben ist. Sie konnen die Zeile
neu messen, wenn der Rahmen wieder gelb ist.

1 2 3 4 5

i Klicken Sie hier, um eine Videoanleitung zu sehen

€} Startseite < Zuriick

When you have measured all five lines correctly, click “Next”. The second target is then created for
you.
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Second target

Proceed with printing, drying and measuring the second target exactly as with the first one. The
second target cannot be skipped like the first one, since it is only being created by the current
measuring values.

« ColorHunki SPECTRUM
Datei ?

Drucker profilieren

Zweites Target drucken

Drucken...

) Startseite < Zuriick

Save profile

After the series of colours has been imported, the “Create profile” dialogue opens. Here, you can
save the new profile created on your PC under the suggested profile name or a name you choose
yourself. To do this, click “Save”. The program now calculates the profile for your printer. After this,
you can create a reminder date for the new profile. Then click “Next”.

Note: If the system has not been able to carry out the profiling process properly, the profile created
cannot be saved and you see a system message that profiling has failed. Make sure that you have
the necessary administration and writing privileges on this PC and repeat the procedure.
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AppSet

With this function, X-Rite offers automatic import of your printer profile to other programs such as
Adobe Creative Suite, CorelDraw or QuarkXPress. To guarantee the reliable correct colour profile
import for other programs, we recommend the method shown below on the basis of Adobe
Photoshop CS4 rather than using the AppSet function.

Print settings for Adobe Photoshop CS5 using a profile created with the ColorMunki

In the main menu of Photoshop CS5, choose “Edit”>“Colour settings”. In the “Colour settings” menu
window that subsequently opens, choose the profile you have created with ColorMunki for the
“Workspace colours>RGB workspace colour” area and confirm the changed settings by clicking
“OK”.
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Then open the Photoshop print dialogue by clicking “File”>“Print” in the main menu and carry out
the following settings in the dialogue that opens:

1. Colour handling: “Colour management through Photoshop”
Printer profile: Choose the ICC profile created with the ColorMunki that you selected
previously in the colour settings window.

3. Render priority: “Absolutely colorimetric”
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Note: Do not forget to deactivate the colour management in the printer dialogue window.
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11.2.3 Import of colour hues to SPECTRUM 5

There are two options for importing colours into SPECTRUM 5:

ColorMunki - Import with Explorer
See chapter 4.3.2, “My collections”.

ColorMunki - Import with PHOTOstudio

You can also import colours with the ColorMunki and display similar colours from the Caparol 3D-
System plus colour collection in the “Design” tab of the PHOTOstudio.

First make sure that the ColorMunki is connected to a USB port on your computer. Then place the
ColorMunki wheel on the measurement position (wheel marking facing down). Place the ColorMunki
with its measuring sensor on the colour hue to be imported and press the ColorMunki wheel. The
colour is imported.

Now, the colours of the 3D-System plus colour collection closest to the imported colour hues are
displayed in the “Design” tab.

Note: If the program does not find a matching colour hue in the 3D-System plus collection, the
system browses the “CaparolColor” collection for similar colours.

ColorPen 3D - Interface from ColorPen 3D to SPECTRUM 5

If you own the new Caparol ColorPen 3D (Buntstift 3D), you can synchronise the colour-measuring
instrument with the software. With this interface, you can use all the colour hues imported with your
ColorPen 3D for design in SPECTRUM 5.

Synchronise ColorPen 3D with your PC

Before you use ColorPen 3D with SPECTRUM 5, make sure that you have synchronised the colour-
measuring instrument with an Internet-capable computer. Use the software DVD supplied with the
ColorPen 3D program for this.

1. Install the software provided on the “CAPSURE Sync” DVD

2. Connect ColorPen 3D to your computer using the USB cable provided

3. Before you start the CAPSURE Sync program for the first time, make sure the computer is
connected with the Internet

4. Start the X-Rite CAPSURE Sync program via “Start”>“Programs”>“X-Rite”>“CAPSURE
Sync” and then click the “Synchronise” button

5. Your ColorPen 3D program is now updated with the latest colour kit data from the Internet

Synchronise ColorPen3D with Explorer
See chapter 4.3.2, “My collections”.
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12. SUPPORT
12.1 Training

Training is offered throughout Germany to improve SPECTRUM know-how. The basic and advanced
training courses are held as one-day classes from 10:00-17:00. The maximum number of participants
is 12 (minimum number of participants: 10). There are training laptops available for the participants to
work together during training.

Course contents and current training schedule: http://www.spectrum.eu/en/trainings.htmi

12.2 Website

The SPECTRUM website www.spectrum.eu provides you with all the information you need about
SPECTRUM:

- Training schedule for the current and upcoming year
- Information about all SPECTRUM products

- Information about products for your own marketing
- Technical support hotline

- Contact information

The website is available in both English and German

12.3 Contact

Support for technical questions

If you should have any technical questions that cannot be answered through the manual or our
website, our support team will be happy to help. Our employees will help you find answers to all the
technical questions you have that are related to SPECTRUM 5:

e-Mail: spectrumsupport@caparol.de

Service Line (chargeable):
Monday — Friday from 9:00-12:00 and 13:00-16:00

In Germany: 0180 — 5 26 56 87
The rate from a German landline is 0.14 Euros per minute.
Calls from mobile networks cost a maximum of 0.42 Euros per minute.

Outside Germany: +49 180 — 5 26 56 87
The costs for the caller are set by the fees of the foreign communication supplier for a call to
Germany. These may vary depending on the country and the service provider.

You will find the full Caparol product range, including all technical information, at:
www.caparol.de
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